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Remote Payroll Capabilities and Benefits 
The Remote Payroll (RP) Module assists with: 

 Precise Hour Logging and Coding:  The hh2 system assists in logging and 
categorizing every hour of work with precision, providing accurate insights into time 
allocation for more effective resource management and project planning. 
 

 Effortless Data Routing: Seamlessly route time tracking data to all stakeholders, 
including end users, in real-time, promoting enhanced collaboration, transparency, 
and informed decision-making through accessible, relevant time data. 
 

 Integration with Accounting Systems:  Synchronize time tracking seamlessly with 
the accounting system, streamlining financial reporting by automatically linking 
time data with the accounting software, eliminating manual data entry errors, and 
ensuring precise billing and payroll processes. 
 

 Comprehensive Time Entry and Management:  Easily enter, code, submit, route, 
and import time within the system, effectively managing all facets of time tracking, 
from data entry to approval workflows. This simplifies time management processes, 
reducing administrative overhead, and ensuring compliance. 
 

 Flexible Time Entry Methods: Enter time using daily, weekly, or batch 
methodologies to suit workflow and preferences, this allows the user to adapt to 
deadlines while maintaining precise records. 
 

 Time-Saving Autofill and Copy Functions: Automate data entry using autofill and 
copy time functions to significantly speed up the process, reducing repetitive tasks 
and increasing productivity, thus allowing more focus on critical activities. 
 

 Customizable Routing and Approval Workflows:  Users can implement 
customizable routing and approval systems within their organization, empowering 
them to define approval processes tailored to their unique needs and hierarchical 
structure. This customization significantly improves efficiency by ensuring that time 
entries follow the appropriate path for review and authorization, ultimately reducing 
bottlenecks in the workflow.  
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Users that will Benefit from this User Guide 
 Payroll Clerk 
 Field Supervisor 
 Project Manager 
 Payroll Manager 
 Payroll Administrator 

 
Note: A Payroll Administrator may also function as a Payroll Manager.  

Note: A comprehensive Glossary of Terms is available at the end of this document. It 
includes hh2 terminology for all product areas and some general industry language. 

Note: This User Guide is intended to be used alongside the software for maximum 
comprehension.  
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Home Page 
Upon log in, the user is brought to the Home Page. 

The Home Page will appear differently for different users depending on the modules 
purchased, the user role, and permissions granted. 

This is an example of how the Home Page may appear for a Foreman out in the field.  

Note: The Home Page  icon is present on all pages. A colored Home Page icon indicates 

the user is situated on the Home Page. Use this icon to navigate back to the Home Page.  
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This is how a Home Page may appear for users such as a manager, with many permissions.  

The Modules the user has access to are listed in the left column.  

Modules include: 

▪ Remote Payroll indicated by the RP link. 

▪ Document Flow indicated by the AP link. 

▪ Field Reports indicated by the FR link. 

▪ Human Resources indicated by the HR link. 

▪ Pay Stubs indicated by the PS link. 

▪ Field Service indicated by the FS link 

▪ The iPaaS Channel iPaSS link. This channel is for users that synchronize data 
between the hh2 and 3rd party providers such as Procore, Autodesk and Trimble. 

 
Each link will take the user to the associated module of the hh2 system by clicking on it.  
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The Phone  icon sits below the Module links. The Phone icon is used to reach out to 

hh2 Customer Support, after the implementation process. When selected, the Get Help 
From hh2 Cloud Services Page displays.  

To Submit a Customer Support Ticket: 

1. Go to the Home Page. 
2. Select the Phone Icon. 

3. Select the Submit Support Ticket tab in the upper left corner. 
4. Enter any information that has not automatically populated from the User Profile. 
5. Select Add Attachments if there are supporting documents. 
6. Select Submit Support Ticket. 
7. A Customer Support Agent will reach the individual with the contact information 

provided.   



Version 2 030424 hh2 User Guide-Remote Payroll-Manager Role  Page 10 of 171 

To Search the Knowledgebase: 

1. From the Home Page, select the Phone icon.  
2. Select Search Knowledgebase. 
3. Click on the words, “Check out the knowledge base!” 

4. Search the knowledge base using key words in the Search field or select a box by 
product area. 

5. Close the browser when complete to return to the Home Page.  
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To Contact hh2: 

1. Select the Contact Us  icon at the bottom of any page. This will be 
displayed for Administrators only. 

2. Enter the data requested. 
3. Select Start Chatting. 

4. Type your message and an expert will reply. 
5. When complete, select X. 
6. Select Confirm End Chat. 
7. Select Close. 

Note: Call Support and Live chat are an add on subscriptions available to Pro Support 
customers and only available to users with System Administrator permissions enabled.  
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To Contact Your Administrator: 

This allows the user to contact the system administrator at the construction company.  

1. From the Home Page, select the Phone icon.  
2. Select the Contact Your Administrator tab. 

3. The contact information will be provided.   
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The About Icon: 

The About  icon provides the user with version and server information. This is useful 

information when contacting Customer Support. 
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The Top Task Bar on the Home Page 

Along the top of the Home Page there are other tools. Those tools include the Search 
Sitemap tool, the User Avatar, and User Profile Information. 

 

The Search Sitemap  field allows the user to search for any feature the user 

has permission to access. 

 

To Use the Search Sitemap: 

1. Enter a topic or partial topic. 
2. The field will auto-populate with potential topics. 

3. Select the topic title with a click. 
4. The system will automatically navigate the user to the associated hh2 page if 

permissions are granted to that user.   
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User Avatar: 

By clicking on the User Avatar  icon or username, the Profile Data Picklist and 

associated links appear. 

To Upload a Photo: 

1. Select the User Avatar  icon or username. 
2. Select Change My Photo.  

3. Select the Folder  icon to browse for an image. 
4. Select the file that contains the photo. 
5. Select Open. 
6. The image can be sized using the + and – icons. 
7. Select Save Image. 
8. Select Delete Image to delete the current photo.  
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To Change Email or Password Information: 

1. Select the User Avatar  icon or username. 
2. Select Change My Email/Password. 

3. Enter the Email and Verify the Email Address. 
4. Enter Phone and Cell Numbers. These numbers are used for contact information 

when submitting a Support Ticket. 
5. Enter and Confirm a new password. 
6. Select Save Information.  
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To Change User Settings 

User Settings are unique to each user.  

1. Select the User Avatar  icon or username. 
2. Select Change My User Settings. 

In the General Tab of the User Settings Page, users can select their Picklist preference. A 
Picklist, also known as a dropdown list, is a menu-like interface element often seen in 
forms and websites, offering users a set of predetermined choices to pick from, enhancing 
data entry efficiency and uniformity. In hh2 Picklists are either in Card View or List View 
format. The default is Card View. 

To Select a Picklist Preference: 

1. Select the User Avatar  icon or username. 
2. Select Change My User Settings. 
3. Select the General tab. 
4. Click the Picklist arrow. 
5. Select user’s preference (either Card View or List View). 
6. When the Ajax  icon appears, the selection has been saved.  
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In the Notification Settings Tab of the User Settings Page, users can choose how they wish 
to be notified of events that relate specifically to their job role. For example, a user in the 
Admin Role may wish to receive notifications when overtime occurs. Other users may wish 
to know when certifications expire or when actions related to invoices are required by 
them. These notifications can occur via push notifications, email, both or not at all. 

To Set Notification Settings: 

1. Select the User Avatar  icon or username. 
2. Select User Settings>the Notification Settings tab. 
3. Check Overdue Labor Time (if using the Remote Payroll Module) to be notified of 

Overtime.  
4. Next to Certification Expiration, check the preferred method of notification when 

Certifications have expired (if using the HR Module): Push Notification, mail, both or 
uncheck for no notifications.  

5. Next to Queue Digest, check the preferred method of notification when there are 
Workflow items in the user’s Primary Queue to be approved or rejected:  Push 
Notification, Email, both or uncheck for no notifications. This is used in conjunction 
with the Document Flow module. 
 

User Photo Tab of the User Settings Page. See To Upload a Photo. 
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The Middle of the Home Page  

The appearance of the Home Page's middle section will vary depending on the modules 
purchased, user roles, and permissions. Administrators and Managers will experience 
different functionality on their Home Page than other users. 

However, all users will have: 

▪ Their most important pages, based on the modules and permissions they use. 

▪ News From hh2 Cloud Services, with information on the latest software updates. 

▪ Links to Instructional Videos. 

▪ A Bookmarks section that allows quick access to important websites. 

▪ A User Setup link to set their personal settings. 

▪ Your Company’s Data.  
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The Tool Tip 

Throughout the system, the Tool Tip can be used to obtain a quick description of the 
associated item. 

To Use the Tool Tip: 

1. Hover the mouse over the topic where additional information is needed. In this case, 
Pay Period End Day. It will turn white. 

2. A description will automatically display. 
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System Setup and Configuration  
Prior to using the Remote Payroll module, the following set up and configurations are 
required: 

Home Page: 

✓ User Set Up 

✓ System Settings 

✓ Your Company’s Data Section 
 

Remote Payroll Page: 

✓ System Settings 

✓ Payroll Users (permissions set for Payroll Managers and Administrators) 

✓ Employees 

✓ Equipment (if applicable) 

✓ Payroll Groups 

✓ Jobs 

✓ Standard Accumulations 

✓ G.L. Accounts 

✓ Pay Types 

✓ Pay Type Groups 

✓ Shifts (if applicable) 

✓ Manager Types (if applicable) 

✓ Integration Formats 
 

In general, when an Administrator signs into hh2, set up and configuration will be located 
on the right side of the page and use tools are located on the left side of the page. 
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The key sections the software utilizes for Remote Payroll are located on the left side of the 
RP Home Page. They are: 

▪ RP>Time Sheet 

▪ RP>Time Record Entry 

▪ RP>Time Approval 

▪ RP>Labor Export 

▪ RP>Reporting  

▪ RP>Punches and Attendance and RP>Equipment Revenue, if applicable.  
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The Remote Payroll Process  
There are four steps in the Remote Payroll process. 

1. Time Entry: Typically, users in the field will enter their time for labor and equipment 
(if applicable). This can be completed via the webpage or mobile application. Time 
may also be added via a Punch Clock method. 
 

2. Workflow: The time will then be sent through the Approval Path of the Payroll Group 
by which the employee is designated. This provides individuals in various job roles 
to review the time prior to the Payroll Manager conducting a final review and 
approval. During the Workflow step, time can be approved, denied, modified, and 
promoted to levels within the Approval Path.  
 

3. Review and Final Approval: The Payroll Manager is the last job role in the Approval 
Path. All time must be reviewed for correct coding by the Payroll Manager. There 
are several ways for the Payroll Manager to review submitted time. Reports within 
hh2 can assist with this process. After the Payroll Manager ensures the time is 
coded correctly, final approval must occur.  
 

4. Export to the Accounting System: After the time has been entered, approved, 
reviewed, and received final approval, it is then exported to the accounting system.  
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Step 1: Time Entry 
Employee time can be entered in the following ways for Labor: 

▪ Via the Labor Time Sheet 

▪ Via the Time Record Entry 

▪ Through the Punch Clock, if enabled. See Punches and Attendance. 

▪ Via Mobile Apps by users in the field 
 

 
Time can be logged and coded against Equipment in the following ways: 

▪ Via the Equipment Revenue Time Sheet 

▪ Via the Equipment Time Record Entry 

▪ Via the Labor Time Sheet 

▪ From Mobile Apps users in the field, using similar pages.  

▪ See Equipment.   
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Time Sheet (Labor Time Sheet) 

The Labor Time Sheet is where the Payroll Manager can view, code, and add hours. 
However, most often, employees will add their own time, or time for employees they 
manage. This is dependent upon the Approval Path set up. Users will add their time either 
from the website or a mobile application. This guide will address time management from 
the website.  

Navigation:  RP>Track Labor Time>Time Sheet 

The Labor Time Sheet Page filters by: 

▪ Payroll Group 

▪ Employee Name  

▪ Pay Period 

▪ Pay Type Group  

 

On the Labor Time Sheet, the Payroll Manager can toggle between Weekly and Daily views 

using the Weekly View   icon in the upper left corner and move quickly between 
employees using < or >. Daily views are considered a shared view, and the user can see 
more than one employee at a time. 

Note:  The order of the search fields will vary based on the Weekly or Daily view of the 
page.   
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To Add Time to the Labor Time Sheet Page Using the Weekly View: 

This feature will allow the user to add time for one employee for a week (or Pay Period as 
defined in the Remote Payroll>Settings >System Settings>General Settings>Pay Period 
Length).  

1. Navigate to the Labor Time Sheet (RP>Track Labor Time Sheet>Time Sheet). 

2. Select the Weekly View  icon in the upper left corner of the Labor Time Sheet. 
3. Select the Payroll Group. 
4. Select the Employee. 
5. Select the Pay Period. 
6. Select the Pay Type Group. 
7. If the appropriate Job and Cost Code is listed, simply key the hours in the applicable 

box adjacent to the Cost Code. The time will automatically save. Jobs and Cost 
Codes will display after the first time they have been added to the Labor Time Sheet.  

8. If the appropriate Job and Cost Code is not listed, Select Add Jobs/Codes to Time 
Sheet to add a Job or Cost Code to the Labor Time Sheet and proceed with the 
steps that follow. Note: If the option for Default Coding is selected in the Payroll 
Group (RP>Payroll Users and Groups>Payroll Groups>specific Payroll 
Group>Settings>Default Coding), the user can choose to code to Default Coding 
instead of a Job and Cost Code.  
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9. Select a Job on the Add Jobs and Codes to Time Sheet Page. 
10. Select a Cost Code. 
11. Select Add Selected Items from the Select a Standard Cost Code Page. 
12. Select a GL Account, Certification Class, Shift, or Union information, if applicable.  
13. Select Add to Time Sheet. Note: Information entered can be removed using the 

Delete  icon. 
14. The New Batch feature (in the upper right corner) allows the user to continue to 

code multiple Jobs and Cost Codes to the Labor Time Sheet without having to exit 
and reenter the Add Jobs and Codes to Time Sheet Page. This is a handy feature if 
multiple Jobs and/or Cost codes are added at once. See To Add Multiple Jobs and 
Cost Codes to a Labor Time Sheet.  

15. Once the Job and Cost Code is added onto the Labor Time Sheet, key the 
appropriate number of hours for each Pay Type adjacent to the Cost Code (just as in 
step 7). Pay Types are color coded. Notice the Pay Legend at the bottom of the 
page.  

Note: The Pay Type hour fields adjacent to the Job Code (or Default Coding) are where 
time is keyed versus the Pay Type hour fields at the bottom of the page which represent 
totals. 

 

Note: This process will change based on Payroll Settings and User Preferences. See Unit 
Custom in the Payroll Group and Quick Time Setting in User Settings.  
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To Add Time to the Labor Time Sheet Page Using the Daily View: 

This feature allows the user to add time for multiple employees in a Payroll Group daily.  

1. Navigate to the Labor Time Sheet (RP>Track Labor Time>Time Sheet). 

2. Select the Daily view in the upper left corner.  
3. Select the Payroll Group. 
4. Select the Pay Type Group. 
5. Select the Date. 
6. On the Labor Time Sheet, key the appropriate number of hours for each Pay Type in 

the column beneath the employee’s name by Job Code and Cost Code. If no Cost 
Code was selected the line item will read Default Coding. Pay Types are color 
coded. Notice the Pay Legend at the bottom of the page. 

7. Jobs and Cost Codes will display once they have been added to the Labor Time 
Sheet.  

8. If the appropriate Job and Cost Code is not listed, Select Add Jobs/Codes to Time 
Sheet to add a Job or Cost Code to the Labor Time Sheet. 
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9. Select a Job on the Add Jobs and Codes to Time Sheet Page. 
10. Select a Cost Code. 
11. Select Add Selected Items from the Select a Standard Cost Code Page. 
12. Select a GL Account, Certification Class, Shift, or Union information, if applicable.  
13. Select Add to Time Sheet. Note: Information entered can be removed using the 

Delete  icon. 
14. The New Batch feature allows the user to continue to code multiple Jobs and Cost 

Codes to the Labor Time Sheet without having to exit and reenter the Add Jobs and 
Codes to Time Sheet Page. This is a handy feature if multiple Jobs and/or Cost 
codes are added at once. See To Add Multiple Jobs and Cost Codes to a Labor Time 
Sheet.  
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Unit Custom in the Payroll Group and Quick Time Setting in User Settings: 
 
The Add Time Record Page may be displayed based on the Payroll Group or by user 
preference. This feature allows for unit specific comments to be made. Use Case: Some 
construction companies want to force the Add Time Record Page to appear, so there is a 
place to house a Work Order or Equipment Number, for instance, in the Description field or 
Unit Custom fields on the Add Time Record Page.  
 
To Require or Enable the Add Time Record Page to Display During Time Entry:  
 

1. For set up by Payroll Group: Navigate to RP>Payroll Users and Groups>Payroll 
Groups>specific Payroll Group>Settings>Unit Customs >Enabled. The Unit 
Customs can be customized to meet the needs of the construction company for the 
specific Payroll Group. For instance, the Unit Customs field may be set to require 
entry or a Work Order number, Equipment number or other tracking needs of the 
construction company.  

 
Unit Customs may be set to: 
 

▪ Disabled (which will enable the regular time entry process only without the Add 
Time Record Page) 

▪ Enabled (which will display the Add Time Record Page during time entry)  
▪ Required (which will require entry into a field during time entry).  
▪ Note: Unit Descriptions may be set to Enabled, Disabled or Required 
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Further, the Unit Customs fields are named in RP>Settings>System Settings>Unit 
Details>name the field, such as Work Order or Equipment. 

In the example below, Field 1 Label would correspond with the Unit Custom 1 Field (W.O 
Number) in the Payroll Group.  

2. For set up by User Preference: The logged-in user may also wish to set their user 
specific preferences to force the Add Time Record Page to be displayed. This will 
enable the user to write an entry in the Description field. To set up the User’s 
Specific Preference: RP>Track Labor Time>Time Sheet>More…(at the 
top)>Settings>User Settings>Quick Time>Always or Click and Hold. The Default is 
Disabled and will move the user through the process previously described for 
Adding Time to the Labor Time Sheet for the Weekly and Daily Views. 
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3. When either of these settings are enabled the Add Time Record Page will display 
once the Pay Type hours are entered adjacent to the Job Code (or Default Coding) 
on the Labor Time Sheet. 

4. Enter the number of hours in the Units field. Add a Description and if a Unit Custom 
field was set up, it will be either required or available for data entry, based on the 
aforementioned set up.  

5. Check the Coding box to save the time Units and add the coding to the Labor Time 
Sheet for later use.  

6. Select Save Time. 
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Comments: 

The Comments  icon: Employees or managers can enter a comment on the Labor 
Time Sheet (RP>Track Labor Time>Time Sheet). When a comment is added on the Labor 
Time Sheet, the comment icon will be shown in color on both the Labor Time Sheet and 
Labor Time Approval Pages. 

 
Use Case for Comments:  Comments may be used to explain time. For instance, an 
employee who only works five hours, due to a dental appointment can comment about the 
five-hour day. This feature aids the Payroll Manager and others in understanding 
discrepancies when reviewing time. 

Note: The Daily comment at the bottom of the Labor Time Sheet encompasses the entire 
day, while the Unit Descriptions (added on the Add Time Record) are specific to a line item 
on the Labor Time Sheet. Unit Comments will color the box on the Labor Time Sheet, so the 
Administrator is aware there is a comment associated with the time.  

 

Payroll Managers may also add a comment to the time.  
 

To Add a Comment:  

1. Select the Comments  icon at the bottom of the Labor Time Sheet. 
2. Enter the comment in the Comments section.  
3. Select Save Comments. 
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To Add Multiple Jobs and Cost Codes to a Labor Time Sheet Using the New Batch 
Feature: 

The New Batch feature allows the user to continue to code multiple Jobs and Cost Codes to 
the Labor Time Sheet without having to exit and reenter the Add Jobs and Codes to Time 
Sheet Page. This is a handy feature if multiple Jobs and/or Cost codes are added at once. 

1.  Select the Add More Cost Codes  icon on the Job line item from the Labor Time 
Sheet.  

2. Select the Cost Code. Note: Multiple Cost Codes can be added.  
3. Select Add Selected Items.  

4. Select New Batch. 
5. Enter the Job and/or Cost Code.  
6. Select Add Selected Items. 
7. Select New Batch. 
8. Continue this process until all Jobs and/or Cost Codes have been entered. 
9. Select Add to Time Sheet. The information will be added to the Labor Time Sheet.  

Note: This feature is also accessible from the Add Jobs/Cost Code to Time Sheet at the 
bottom of the Labor Time Sheet. The difference between the two methods is using the Add 
Job Cost Code Codes  icon next to the Job on the Labor Time Sheet, pre-loads the Job 
for the user and the Add Jobs/Cost Code at the bottom of the Labor Time Sheet does not.  
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Tools on the Labor Time Sheet Page 

When More… at the top of the Labor Time Sheet is selected, a variety of other tools appear 
for use on the Labor Time Sheet Page.  

Refresh: The Refresh  icon will refresh the time sheet data.  

Time: The Time  icon allows the user to add a time record.  

To Add Time Using the Time  icon: 

Note: This provides an alternative method to enter time instead of keying it directly onto 
the Labor Time Sheet Page.  

1. Select More… for the top of the Labor Time Sheet. 
2. Select the Time  icon from the Labor Time Sheet Page. 

3. Enter the Employee’s name. 
4. Enter the Date. 
5. Enter the Pay Type. 
6. Enter the Units (of time). 
7. Enter any other information needed (a Description, Job, Cost Code, Certification 

Class). 
8. Check the Coding box to save the time Units and add the coding to the Labor Time 

Sheet for later use.  
9. Select Save Time.  

10. The time will be displayed on the Labor Time Sheet.   
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Look: The Look  icon allows the user to view all time entered for the employee or 

employees (if using the Daily view).  

To View All Time: 

1. Select More… for the top of the Labor Time Sheet. 
2. Select the Look  icon. 

3. Select Close. 
 

Note: The Approval Log link will allow the user to see where the time is in the Workflow 
based on the Approval Path. See Approval Log. 
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Members: The Members  icon allows the user to add and remove members from a 

Payroll Group. 

To Add a Member to a Payroll Group: 

1. Select More… for the top of the Labor Time Sheet. 

2. Select the Members  icon.  
3. Search for the member to add in the Search field. 
4. Select the name under the Not Assigned section. 
5. Select the Add  icon.  
6. Select Close. 

 

To Delete Members from a Payroll Group: 

1. Select More… for the top of the Labor Time Sheet. 

2. Select the Members  icon.  
3. Search for the member to delete in the Search field. 
4. Select the name under the Assigned Employees section. 

5. Select the Delete  icon.  
6. Select Close.  
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Excel: The Excel  icon creates an Excel spreadsheet with the employee’s time. It must 

be downloaded to view. A Pivot Table may be inserted into the Excel spreadsheet to create 
customized reports for easy review of time. Use Cases: Used to create customized reports 
requested by others or to quickly review time.  

To Create a Pivot Table within the Excel Spreadsheet: 

1. Select More… for the top of the Labor Time Sheet. 
2. Select the Excel  icon. 
3. The spreadsheet will be downloaded and can be found in the Downloads folder on 

the user’s computer.  
4. Highlight the data in the Excel spreadsheet. 
5. Select Insert>Pivot Table in Excel. 
6. Choose New Worksheet. 
7. Select Ok. 
8. Check the data to be placed in the customized report in Pivot Table Fields, such as 

Employee Number, Employee Name, Payroll Group, and other data. 

9. Drag the items (for instance, Employee Number) to the Columns section (most 
typically used) or Rows section.  

10. Select File>Save as, name the file. 
11. Select Save.  
12. Print or Share the report as needed. 
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PDF: The PDF  icon creates a physical time sheet each employee. It, too, must be 

downloaded to view and can be found in the user’s Download folder.  

1. Select More… for the top of the Labor Time Sheet. 

2. Select the PDF  icon. 
3. Check the Downloads folder for the report. 
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Help:  The Help  icon takes the user to related Knowledge Base articles.  

1. Select More… for the top of the Labor Time Sheet. 
2. Select the Help  icon. 

3. Select the article. 
4. Close the associated tabs when done.  

  



Version 2 030424 hh2 User Guide-Remote Payroll-Manager Role  Page 42 of 171 

User Settings: The User Settings  icon allows the user to set settings specific to the 

individual user’s preference and needs.  

Preferences include: 

▪ The Default View (weekly or daily). This setting will carry over between the Time 
Entry Record and the Labor Time Sheet for the user.  

▪ Pay Period Dates (current or previous) 

▪ Pay Period End Date (day of week) 

▪ The number of Pay Period days (7 or 14) 

▪ A Bi-weekly End Date 

▪ Employee Sort (name or code) 

▪ Quick Time (disabled, click and hold or always).  

o Click and hold will display the Add Time Record Page when the user clicks 
and holds on the time boxes on the Labor Time Sheet, for a quick time entry. 
If there are unwanted hours keyed on the Labor Time Sheet, click and hold 
allows them to be changed without backspacing and deleting.  

o Disabled means the user cannot click and hold. The Add Time Record Page 
does not display. 

o  Always will display the Add Time Record Page all the time during time entry.  

▪ Primary Button (allows the user to set an additional tool outside More...on the top of 
the page on the Time Sheet (RP>Track Labor Time>Time Sheet)). 

▪ Attendance (form or punch) 
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▪ Shift Start and End times 

▪ For PDF reports list by (group by Employee, Jobs, or Payroll Group)  

▪ Sort PDF data by (Employee Name or Number or by Job Name or Job Number).  
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Additional Tools on the Labor Time Sheet 

More…adjacent to the days of the week (on the Weekly view) or the employee names (on 
the Daily view) allows the user to access even more tools. These tools are available to both 
the Payroll Manager and the Field user when using the website.  

 

Note: The Signature  icon is not present on the Daily view, as the Daily view represents 

time for more than one employee.  
 

Clear: The Clear  icon will clear all time entered on the Labor Time Sheet.  

To Clear All Time: 

1. Select More… adjacent to the days of the week on the Weekly view or the employee 
names on the Daily view. 

2. Select the Clear  icon.  
 

3. When OK is selected, all time will be cleared from the Labor Time Sheet.   
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Auto-Fill: The Auto-Fill  icon will populate the Labor Time Sheet, with the previous pay 

period’s time.  

To-Fill the Labor Time Sheet with the Previous Pay Period’s Time: 

1. Select More… adjacent to the days of the week on the Weekly view or the employee 
names on the Daily view. 

2. Select the Auto-Fill  icon.  

3. When OK is selected, the previous pay period’s time will fill the Labor Time Sheet.  
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Move:  The Move  icon will move time to either a previous or future pay period.  

 

To Move Time to a Previous or the Following Pay Period: 

1. Select More… adjacent to the days of the week on the Weekly view or the employee 
names on the Daily view. 

2. Select the Move Time  icon.  

3. Select the Period to move the time to (Previous or Following Pay Period) from the 
Picklist. 

4. Check if Daily Comments or Attendance should be moved. 
5. Select Move Time.  
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Copy: The Copy  icon allows the Payroll Manager to copy time entries from one 

employee to other employees.  
 
To Copy Time from One Employee to Other Employees: 

1. Select More… adjacent to the days of the week on the Weekly view or the employee 
names on the Daily view. 

2. Select the Copy Time  icon.  

3. Select the Employee from whom the time will be copied in the Copy From field. 
4. Check the Days to be copied. 
5. Select if Daily Comments and Attendance will be copied. 
6. Choose the Employees to copy the time to in the Copy to Employees section. Note:  

All Employees is an option at the top of the Copy To Employees column. 
7. Select Copy Time.  
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Equipment Revenue: The Equipment Revenue  icon allows time to be added to 

Equipment Revenue. By default, this will copy any of the user’s existing labor time with the 
option to adjust units, codes, and categories. Note: This feature is used to add time against 
a piece of equipment, not to add employee time to a piece of equipment.  

To Add Time to Equipment Revenue: 

1. Select More… adjacent to the days of the week on the Weekly view or the employee 
names on the Daily view. 

2. Select the Equipment Revenue  icon.  

3. Select Add Time. 
4. Select a Date from the Add Time to Distribution Page.  
5. Select Okay. 
6. Enter the time (units). 
7. Select the Equipment, Job, Cost Code and Cost or Revenue Code. 
8. Select Save Equipment Time. 
9. Select Save Time 

10. Select Close.  
 

Note: The Add Time feature in the upper right corner allows the user to continue to add 
time without exiting the page. 
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Time may be split off using the Split  icon. Use Case: This may be used when splitting 

equipment time between Jobs.  

To Split Time on Equipment:   

1. Select More… adjacent to the days of the week on the Weekly view or the employee 
names on the Daily view. 

2. Select the Equipment Revenue  icon.  

3. Select the Split  icon 

4. Enter the amount to split off and select Ok. 
5. The Split Time will display as two entries.  
6. Select the Equipment, Job, and Cost Code. 
7. Select Save Equipment Time.  
8. Select Close.   
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The Promote, Deny and Reclaim icons are used primarily during the Workflow step of the 
Remote Payroll process. During the Workflow step, the Payroll Manager primarily works 
from the Labor Time Approval Page (RP>Track Labor Time>Time Approval). However, time 
can be promoted, denied, and reclaimed from the Labor Time Sheet, as well. From the 
Labor Time Sheet, all time is promoted, denied, or reclaimed. While on the Labor Time 
Approval Page, select time can be promoted, denied, or reclaimed specific to the 
employee. See Workflow. 

 

Promote: The Promote  icon allows the user to promote all unapproved time to the next 
level in the Approval Path. This is used during the Workflow step, as time progresses 
through the Approval Path.  

To Promote All Unapproved Time: 

1. Select More… adjacent to the days of the week on the Weekly view or the employee 
names on the Daily view. 

2. Select the Promote  icon.  

3. Select Ok.  
4. This will promote the time and bypass the approval of those below the user logged 

in and will bring the time to their level to modify and approve. 
5. Once promoted, time will still need approval.  

  



Version 2 030424 hh2 User Guide-Remote Payroll-Manager Role  Page 51 of 171 

Deny:  The Deny  icon allows the user to deny all-ready time from the Labor Time Sheet. 
This is used during the Workflow step, as time progresses through the Approval Path. See 
Workflow. 
 

To Deny All Ready Time:  

1. Select More… adjacent to the days of the week on the Weekly view or the employee 
names on the Daily view. 

2. Select the Deny  icon.  

3. Select the Employee. 
4. Select the Pay Period Date 
5. Enter a Reason for denial (required).  
6. Select Submit Denial. 
7. The status will change to Promote on the Labor Time Sheet. The Payroll Manager 

will no longer have access to modify the hours, since the time is no longer at the 
Payroll Manager level in the Workflow.  

Note: This process will only deny time back down one level in the Approval Path. This 
process will need to be repeated by others in the Approval Path until it reaches the desired 
level.  
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Reclaim: The Reclaim  icon will reclaim all immediately approved time. This action will 
change the status from Reclaim to back to ready for approval (Approve status). This is used 
during the Workflow step, as time progresses through the Approval Path. See Workflow. 

To Reclaim All Approved Time: 

1. Select More… adjacent to the days of the week on the Weekly view or the employee 
names on the Daily view. 

2. Select the Reclaim  icon.  
3. Select Ok for Approval Confirmation.  

 
Note: Once time has been reviewed by the level above, the Reclaim icon will no longer 
work, and the time will need to be denied. 
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Sign: The Signature  icon provides the space for the employee’s signature.  

To Sign a Labor Time Sheet:  

Note: The Signature  icon is not present on the Daily view, as it represents time for 

more than one employee.  

1. Select More… adjacent to the days of the week on the Weekly view.  
2. Select the Signature  icon from either the Labor Time Sheet Page or the Labor 

Time Approval Page. 
 

3. Check the boxes. 
4. Add any comments, if applicable. 
5. Place the cursor in the signature box. 
6. To clear the signature, select Shift + Click.  
7. Select Accept Signature. 

 

Note: It is recommended that the entire week is filled out prior to adding a signature, as 
signatures cannot be re-signed or deleted.  
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Job Explorer: Allows the user to conduct a detailed search for Job Codes, including active 
and inactive Job Codes. This icon displays adjacent to the Job.  

To Search Job Codes: 

1. Select the Job Explorer  icon.  
2. Use the Search Field to find a Job.  
3. Filter by Active, Inactive and All Jobs.  
4. The Job Details  icon allows for a further search.  
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Add More Cost Codes: Allows the user to add additional Cost Codes to the Labor Time 
Sheet.  

To Add More Cost Codes: 

1. Select the Add More Cost Codes  icon on the Job line item.  

2. Select the Cost Code. Note: Multiple Cost Codes can be added.  
3. Select Add Selected Items.  

4. Select Add to Time Sheet. Or select the Delete  icon to delete the code from the 

Labor Time Sheet. When Add to Time Sheet is selected the Job and Cost Code will 
display on the Labor Time Sheet. See also To Add Multiple Jobs and Cost Codes to a 
Labor Time Sheet Using the New Batch Feature. 
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Time Record Entry 

Navigation:  RP>Track Labor Time>Time Record Entry 

The Time Record Entry Page provides an alternative means for entering time. It displays in 
a list view rather than a spreadsheet view. Use Case: The Time Record Entry is particularly 
useful when entering batch time entry for multiple employees and/or days.  

Time will display by Payroll Group and Pay Period. The number of employees in a Payroll 
Group will also be displayed with time entered for each by Pay Type, Job, and Cost Code 
(as logged).   
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Tools on Time Record Entry Page 

Auto-Fill: The Auto-Fill  icon is used for ease and speedy time entry, the auto-fill 

feature populates the Time Record Entry with the previous pay period’s time.  

To Use the Auto-Fill Feature: 

1. Select the Auto-Fill  icon.  

2. Select OK. When OK is selected, the previous pay period’s time will fill the Labor 
Time Record Entry Sheet with the previous pay period’s time.  

 

Refresh: The Refresh  icon will refresh the time sheet data.   
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User Settings: The User Settings   icon allows for the user to customize their personal 

preferences regarding Time Entry. This is particularly useful to the Payroll Manager, who 
works in the previous pay period, while others are working in the current pay period, for 
instance. Note: These settings impact both the Labor Time Sheet and the Labor Time 
Approval Page. These same settings can also be set from the Labor Time Sheet. 
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Preferences include: 

▪ The Default View (weekly or daily). This setting will carry over between the Time 
Entry Record and the Labor Time Sheet for the user. 

▪ Pay Period Dates (current or previous) 

▪ Pay Period End Date (day of week) 

▪ The number of Pay Period days (7 or 14) 

▪ A Bi-weekly End Date 

▪ Employee Sort (name or code) 

▪ Quick Time (disabled, click and hold or always).  

o Click and hold will display the Add Time Record Page when the user clicks 
and holds on the time boxes on the Labor Time Sheet, for a quick time entry. 
If there are unwanted hours keyed on the Labor Time Sheet, click and hold 
allows them to be changed without backspacing and deleting.  

o Disabled means the user cannot click and hold. The Add Time Record Page 
does not display. 

o Always will display the Add Time Record Page all the time during time entry.  

▪ Primary Button (allows an additional icon outside of More...on the top of the page 
on the Time Sheet (RP>Track Labor Time>Time Sheet)) 

▪ Attendance (form or punch) 

▪ Shift Start and End times 

▪ For PDF reports list by (group by Employee, Jobs, or Payroll Group)  

▪ Sort PDF data by (Employee Name or Number or by Job Name or Job Number).   
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To Delete Time from the Time Record Entry Page: 

1. Select the Delete  icon. This enables Delete  icons next to each line of time.  

2. Select the Delete  icon for each line item to delete. This will remove the time.   
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To Add Time via the Time Record Entry Page: 

1. Select the Add  icon.  

2. Enter the Employee Name or use the search tool. Add Selected Items. 
3. Enter the Dates and select Add Selected Items (note that multiple days may be 

selected). 
4. Select the Pay Type. 
5. Enter the Units of time. 
6. Enter the Job, using the search tool. 
7. Enter the Cost Code. 
8. Enter the Certification Class, Shifts, Union information, G.L. Account and Category, 

if applicable.  
9. Enter a Description. 

10. Select Save Time.  
11. Select Close once the time is saved. A message will appear when the time has been 

successfully saved.   
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Step 2: Workflow (Approval Path) 
After time is entered, the time follows the Approval Path specified for the Payroll Group 
(RP>Payroll Users and Groups>Payroll Groups>specific Payroll Group>Approval Path tab). 
Note: The Approval Paths are set up by employee level, group manager, or job manager 
roles. Likewise, the Approval Path is structured by levels. These are customizable to meet 
the preferences and needs of the construction company.  

During the Workflow step of the payroll process, Payroll Managers primarily work from the 
Time Approval Page (RP>Track Labor Time>Time Approval) to review and approve time 
prior to exporting it into the accounting system. Changes can be made to time by the 
Payroll Manager on the Labor Time Sheet. If the Payroll Manager opts not to make changes 
themselves, they may deny time to a lower level. See To Deny Time from the Labor Time 
Approval Page.  
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The Labor Time Approval Page 

Navigation: RP>Track Labor Time>Time Approval 

When working from the webpage on a desktop, non-Payroll Managers that are a part of the 
Approval Path will also work from RP>Track Labor Time>Time Approval Page. If a user or 
their job role is not listed in the Approval Path of a Payroll Group (RP>Payroll Users and 
Groups>Payroll Groups>specific Payroll Group>Approval Path tab), access to time is not 
provided on the Labor Time Approval Page.  

From the Labor Time Approval Page, Payroll Managers can:  

▪ Promote Time 

▪ Approve Time 

▪ Reclaim Time 

▪ Create Excel spreadsheets for easy time reconciliation 

▪ Create PDFs for individual time reconciliation 

▪ Lock Time 

▪ Export Time to the accounting system using the Export  icon 

▪ Payroll Managers are usually the last to approve time (as structured in the Approval 
Path). 

From the Labor Time Approval Page, non-Payroll Managers (such as Foreman and 
Supervisors) can: 

▪ Promote Time 

▪ Approve Time 

▪ Reclaim Time  

▪ Create Excel spreadsheets for easy time reconciliation 

▪ Create PDFs for individual time reconciliation 

Note: Non-payroll managers cannot lock or export time. The key differences between users 
that have access to the Labor Time Approval Page and Payroll Managers are that the 
Payroll Manager 1) should be the last to approve time (at highest level in the Approval 
Path), 2) can lock time and 3) export time. Notice these differences in the Labor Time 
Approval Pages that follow. 
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The Labor Time Approval Page for a non-Payroll Manager: 

 

The Labor Time Approval Page for a Payroll Manager:  

Note: If there is more than one person in a job role at a level in the Approval Path, once one 
individual approves time, the others at that level cannot approve time. Selecting the 
Approve icon to approve time is on a first come, first serve basis.  

Note: Payroll Managers will spend most of their time on the Labor Time Approval Page. The 
Time Approval Page provides the Payroll Manager with a location to view employee time, 
check their time totals and approve time prior to export.   
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More About the Labor Time Approval Page 

Navigation: Home Page>Remote Payroll >Time Approval or RP>Track Time>Time 
Approval  

An employee must be assigned to a Payroll Group to be displayed on the Labor Time 
Approval Page.  

The Labor Time Approval Page allows searches by: 

▪ Filters 

▪ The Pay Periods (defaults to the current Pay Period, but can be modified in 
Settings) 

▪ The Employee Name  

▪ By Payroll Group (on the right). Payroll Groups are displayed in alphabetical order.  

Note: The Payroll Manager can click an employee’s name to open the Labor Time Sheet in 
a new tab, and not lose their place on the Labor Time Approval Page.  
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Understanding Time Statuses 

The Time Approval Status is displayed next to each employee’s name on the Labor Time 
Approval Page.  

Promote (red): Indicates the time is at a lower level than the of the user in the Workflow. 
The Payroll Manager is the highest level in the Workflow (as defined by the Approval Path). 
Promote means persons (the employee or individuals in certain job roles) at lower levels 
have not yet approved time. The Promote  icon allows the Payroll Manager or others to 
promote the time to their level for approval. Level 1 in the Workflow does not have the 
ability to promote. Level 1 must select Approve to move the time to higher levels. Once 
Promote is selected, the icon will change to Approve. To determine who (which level) the 
time is held at, the Payroll Manager can view the Approval Log. See Approval Log.  

Approve (gold): Indicates the time has been approved by users at a lower level in the 
Workflow and ready to approve at the Payroll Manager level. Approve indicates the time is 
at the user’s level. Once Approve is selected, the icon will change to Reclaim.  

Reclaim (green): Allows the user to pull the time back to their level in the Workflow after 
approving it for further corrections, if necessary. The Payroll Manager can reclaim at any 
stage of the Workflow up until the time of Export. However, for others in the Workflow, 
Reclaim will only work until the next level person in the Workflow accesses the time.  

Exported (blue): Indicates the time has been exported to the accounting system.  
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Tools on the Labor Time Approval Page 

Filter: The Filter  icon allows the user to filter by Date, Time Status, Job, Child Jobs, Pay 
Groups and Pay Type Conditions (such as equal to, greater than or less than an amount).  

To Use the Filter: 

1. Select the Filters  icon.  
2. Enter the data by which to filter. For conditions, select the Pay Type, the inequality 

sign, and enter the amount. Select the Add   icon.  
3. Select Apply Filters.  
4. The data selected will be displayed on the Labor Time Approval Page.   
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Pay Period:  The system defaults to the current pay period. The system allows the user to 
switch the Pay Period that displays, since most typically the Payroll Manager is processing 
time during a previous pay period. Note: In the User Settings, the user can set their own 
default week to either the current or previous pay period.  

 

To Select a Pay Period other than the default Pay Period: 

1. Select the Calendar  icon next to the Pay Period field.  

2. From the Select a Pay Period Page, choose the Pay Period. 
3. The user can also use the Picklist to select Past or Future Pay Periods.  
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Employee Search: Allows the user to search by employee name. 

On the Labor Time Approval Page, time may be managed individually, or by batch (all 
time). The Promote, Approve and Reclaim icons at the top of the Labor Time Approval 
Page, manage all time on the Labor Time Approval Page. These functions are also available 
on the Labor Time Sheet. See Additional Tools on the Labor Time Sheet. 

Promote: The Promote  icon at the top of the page will promote all time on the Labor 
Time Approval Page to the Approve status, as it functions as a batch feature. Otherwise, 
time can be promoted to the Approve status for each line item simply by selecting Promote 
adjacent to the employee’s time. The job role (person) in Level 1 of the Workflow does not 
have the ability to Promote time.  

To Promote All Time on the Labor Time Approval Page: 

1. Select the Promote  icon. 

2. Select Ok. 
3. All time will be promoted to the Approve status and bypass those in lower Levels. 

 

Approve: The Approve  icon at the top of the page will automatically approve all time on 
the Labor Time Approval Page, acting as a batch feature. 

 

To Approve All Ready Time on the Labor Time Approval Page: 

1. Select the Approve  icon. 
2. This will change the Approve status to Reclaim status.  
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Reclaim: The Reclaim   icon at the top of the page will reclaim all time on the Labor 
Time Approval Page. This will change all time that has already been approved time in 
Reclaim status, back to Approved status, meaning it requires approval once again.  

 

To Reclaim All Approved Time on the Labor Approval Page: 

1. Select the Reclaim  icon. 
2. This will change the Reclaim status back to Approve, meaning it requires action to 

be approved once again.  
 

Lock: The Lock  icon at the top of the page will lock the Pay Period to prevent time from 
being entered and approved after a certain date. This is optional. Use Case: It is 
recommended that after exporting time to the accounting system the Pay Period should be 
locked. This alleviates errors and ensures employees enter time in the correct Pay Period.  

To Lock a Pay Period: 

1. Select the Lock  icon. 
2. This will lock the Pay Period so no additional time may be re-entered.  

 

Export: The Export  icon at the top of the page will export all time approved by the 
highest level in the Approval path (and in the Reclaim status) to the accounting system. 
See Exporting Time to the Accounting System.   
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Excel: The Excel  icon will create a report based on the Pay Period selected, as well as 
which employees have time coded. If the report is blank that means, there was not time 
coded to a filter selected. This provides a convenient way for the Payroll Manager to review 
time quickly and efficiently.  

To Create an Excel Report: 

1. Select the Excel  icon.  
2. Look in Downloads folder for the file.  

3. The Excel spreadsheet allows the user to view all employees on one report. See also 
To Create a Pivot Table within the Excel Spreadsheet for a helpful tip for creating 
customized report for time review.  
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PDF: The PDF  icon will create a PDF report based on the Pay Period selected, as well as 
which employees have time coded. If the report is blank, there was not time coded to the 
filter selected.  

To Create a PDF: 

1. Select the PDF  icon.  
2. Look in the Downloads folder for the file. 

3. This action creates a separate timesheet for each employee selected on a separate 
page.   
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Email: The Email  icon allows the user to send an email to all payroll approvers, with a 
summary digest, of time under their review.  

 

To Send the Summary of Labor Time to all Payroll Approvers Under Their Review: 

1. Select the Email  icon. 

2. Select Ok to email all payroll approvers a summary of time under their review.  
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Settings: The Settings  icon allows the user to customize their own settings, according 
to user preference. These are the same settings seen on both the Labor Time Sheet and 
Time Record Entry. See User Settings. 

Refresh: The Refresh  icon will refresh the Labor Time Approval Page.   
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Tools in the Center of the Labor Time Approval Page 

Quick View: The Quick View  icon next to the employee’s name allows the Payroll 
Manager to view each employee's time. Click the icon to view the time. 

The View All Time Page allows the Payroll Manager to view totals for time. If a line item is 
selected from the View All Time Page, it takes the user to the Labor Time Sheet (RP>Track 
Labor Time>Time Sheet) for easy access to the Labor Time Sheet.  

Note: Any errors found on the View All Time Page will need to be corrected on the Labor 
Time Sheet.  
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Comments: When anyone makes a comment using the daily comment on the Labor Time 
Sheet (RP>Track Labor Time>Time Sheet), it can be viewed not only from the Labor Time 
Sheet, but also on the Time Approval Page. The Comment  icon will be indicated in 
color to inform the user that a comment is present. The comment can be viewed by 
clicking on the Comments  icon on the Labor Time Approval Page. 

Attendance: The Attendance  icon is used with Punch Clock feature and allows the 
user to gain access to the time clock punch information, view history and delete punches. 
See Punches and Attendance.  

 

Signature: The Signature   icon provides an opportunity for those with permissions to 
view an employee’s signature on the Labor Time Approval Page. Those with access to the 
Labor Time Approval Page can add their own signature as well. Note: Signatures can also 
be added on the Time Labor Page (RP>Track Labor Time>Time Sheet>Weekly View). 

 

To Sign a Labor Time Sheet:  

1. Select the Signature  icon from either the Labor Time Sheet Page or the Labor 
Time Approval Page. 

2. Check the boxes. 
3. Add any comments.  
4. Select Shift +Click.  
5. Select Accept Signature. 
6. It is recommended that the entire week is filled out prior to adding a signature, as 

signatures cannot be re-signed or deleted.  
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Roadblock  icon: The Roadblock icon displays roadblocks in the Approval Path.  

 

To View Approval Path Roadblocks: 

1. Select the Roadblock  icon from the Labor Time Approval Page.  

2. Select the Employees tab to view the level at which the time is blocked. 
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3. Select the carrot to view further details in the dropdown.  

The icons at the bottom show the total number of employees needing approval and the 
total number of units needing approval.  

4. Select the Approvers tab to view time. The time in the second column represents 
only time this user can approve. The time in the third column represents time the 
user and one or more users can approve. From the Approvers tab, time stuck with 
no approvers and time waiting on a single approver can be viewed using the icons 
below, respectively. 
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Time Approval by Batch or Single Employee 

Time can be approved as a batch, or by each employee.  

 

To Approve Time as a Batch from the Labor Time Approval Page: 

1. Navigate to the Labor Time Approval Page (RP>Track Labor Time>Time Approval). 
This action was previously noted in the Tools on the Labor Time Approval Page 
section of this document.  

2. Filter by selecting a Payroll Group or by All Payroll Groups. 
3. Select the Approve  Icon at the top of the page.  
4. This will approve all time for the selected filters. The status will change to Reclaim. 

For the Payroll Manager, typically the last role in the Approval Path, once all 
statuses are at Reclaim, the time is ready for export.  

To Approve Time for a Single Employee: 

1. From the Labor Time Approval Page (RP>Track Labor Time>Time Approval), select 
a specific employee. This will navigate the user to the Labor Time Sheet for that 
employee where time may be approved.  

2. Select the Approve  icon for each line item to be approved.  
3. Select Ok in the Approval Confirmation Page.  
4. The line item will turn to a status of Reclaim. For the Payroll Manger, typically the 

last role in the Approval Path, once all statuses are at Reclaim, the time is ready for 
export.  
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To Deny Time from the Labor Time Approval Page: 

Use Case: Payroll Managers may make modifications to the time themselves. However, 
when they do not wish to do so, they can deny time back to a previous level. 

 

1. Select an employee with a click. This will navigate the user back to the Labor Time 
Sheet. 

2. Select More… adjacent to the dates. 
3. Select the Deny  icon. 

4. Enter a reason for denial. 
5. Select Submit Denial. 
6. An alert stating that time has been denied will appear at the top of the Labor Time 

Sheet.  
7. Time will be sent back through the Workflow approval process, except in backwards 

order. Meaning, it will only deny the time back to the previous job role in the 
Workflow (Approval Path) and the Status will change to Promote.  

8. It will send the user, at that level in the Approval Path, an hh2 email notifying them 
that the time was denied back to them in the Workflow (Approval Path).  

9. That previous job role in the Workflow (Approval Path) will need to log in and fix the 
time and select Approve again. The Payroll Manager also has the option to Promote 
the time to their level.  
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Viewing Comments on the Labor Time Approval Page: 

When comments are added on the Labor Time Sheet (RP>Track Time>Labor Time Sheet), 
they can be viewed on the Labor Time Approval Page. Comments will be highlighted in 
color next to the employee’s name indicating there is a comment for the Payroll Manager 
to view.  

 

Note: Comments will be displayed on the Excel Spreadsheet during the final review step.  

 

Promoting Time:  

Time may be promoted or moved to the next level for a single employee by selecting the 
Promote icon next to the employee’s time on the Labor Time Approval Page. This feature 
can be used to move time to the next level in the Approval Path, especially when the 
Payroll Manager has to make final approval and the time has hit roadblocks in the Approval 
Path.  

1. Navigate to RP>Track Labor Time>Time Approval. 

2. Select the Promote  icon next to the employee’s time.  
Select Ok. Time will be promoted to the next level in the Approval Path.   
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Step 3: Review and Final Approval 
 

After time has moved through the Workflow (Approval Path), and the Labor Time Approval 
Page displays the gold Approved status, the Payroll Manager must now review the time for 
accuracy and correct coding. Likewise, the Payroll Manager must execute the final 
approval before exporting the time to the accounting system.  

There are four key ways in which the Payroll Manager may review time prior to final 
approval: 

1. Using the Quick View icon from the Labor Time Approval Page for each employee. 
This will provide a full labor breakdown by day, based on Pay Type.  

2. Reviewing the time sheet from the Labor Time Sheet Page by clicking each 
employee.  

3. Creating an Excel spreadsheet with all employees for the Pay Period. This is an 
efficient method to review time.  

4. Creating PDFs for each time sheet (employee) and reviewing them separately.  
5. Using hh2 Reports. 

 

Note: If navigating from the Labor Time Approval Page, and using the Chrome browser, the 
user can open two tabs. One tab is for the Labor Time Approval Page and the other will be 
for the Labor Time Sheet. This makes it convenient to toggle between the two pages. 
Different browsers behave differently.  
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Review Time Using the Quick View Icon from the Labor Time Approval Page 

Using the Quick View  icon, the Payroll Manager can view employee time by Pay Type. 
Likewise, the Payroll Manager can also determine at which level in the Approval Path time 
has passed.  

To View the Approval History: 

1. Navigate to RP>Track Labor Time>Time Approval 
2. Select the particular employee to view with the Quick View  icon.  

3. Select  

4. The Approval Log will provide the Payroll Manager information as to which level time 
sits at within the Approval Path. In the example above, the individual at Level 1 in 
the Approval Path completed time, as indicated by the date and time.  

5. Select either Back to Time to view time or Close to return to the Labor Time 
Approval Page.  
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Review Time from the Labor Time Sheet Page 

1. Navigate to the Labor Time Sheet (RP>Track Labor Time>Time Sheet). 
2. Select the Weekly View to view individual employee time or select the Daily View to 

view time by Payroll Group, Pay Type Group and Date. 

Note: By clicking on any employee line item from the Labor Time Approval Page, the user 
will be brought directly to back to the Labor Time Sheet for that employee.   
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Review Using an Excel Spreadsheet 

Time can be reviewed using an Excel Spreadsheet from either the Labor Time Sheet 
(RP>Track Labor Time>Time Sheet) or from the Labor Time Approval Page (RP>Track 
Labor Time>Time Approval). This provides the Payroll Manager with a means of viewing all 
employee time at once. See using Excel on the Labor Time Sheet or Excel from the Labor 
Time Approval Page.   
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Review Time Using hh2 Reports 

The hh2 Remote Payroll module offers other reports for time review. 

▪ Labor Detail 

▪ Labor Hours and Productivity Summary 

▪ Equipment Detail 

▪ PDF Time Sheets  
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Labor Detail Report 

This report generates an Excel or PDF file by selected filters.  

1. Navigate to RP>Reporting>Labor Detail.  

2. Select the File Type (Excel File or PDF File) by toggling. The colored File Type is the 
one selected. 

3. Select the Filters  icon. 

4. Enter the From and To Dates, using the Calendar  icon.  
5. Select any other filters required for the report.  
6. Select the filter from the associated Master List and Add Selected Items. 
7. Select Apply Filters.  

Note: Any manager can run reports on information offered in the filters that they have 
permission to access. However, Payroll Managers can report on any information available 
in the filters.   
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Labor Hours and Productivity Summary 

This report generates a PDF summary of budgeted and actual labor hours and production 
units. 

1. Navigate to: RP>Reporting>Labor Hours and Productivity Summary. 
Click on the Magnifying icon . 

2. Select a Job from the Master Job List.  
3. Check Include Productivity and the report will list Hours Estimated, Actual Hours 

and Hours Remaining, along with Cost Codes, and Productivity Targets. 
4. Check Include Sub-Jobs for a breakdown of hours Posted, Pending and Remaining 

for Sub-Jobs.  
5. If both boxes are checked, the report will include all the above information.  
6. Select Generate Report. 
7. Select View  to view the report or Download to download the report. The report 

will be found in the Downloads file on the user’s device.  
  



Version 2 030424 hh2 User Guide-Remote Payroll-Manager Role  Page 89 of 171 

Equipment Detail 

This report will provide a summary of equipment revenue time. The file type is an Excel file.  

1. Navigate to RP> Reporting>Equipment Detail.  
2. Use the Filter  icon to filter the report by date ranges, Payroll Groups, 

Equipment, Jobs, Cost Codes, G.L. Accounts and/or Revenue Codes and Add 
Selected Items.  

3. Select Apply Filters. 
4. Select Settings using the Settings  icon to select the format and whether 

comments should be included.  

5. Select Close. 
6. Search for the Equipment in the Search Field. Equipment time entered and 

approved for the current pay period will populate, along with the associated job 
information.  

7. Select Generate Equipment Detail. 
8. Select Download Equipment Detail.  
9. The report can be found in the Downloads file on the user’s device.   



Version 2 030424 hh2 User Guide-Remote Payroll-Manager Role  Page 90 of 171 

PDF Time Sheets 

A separate timesheet can be created for each employee for review from either the Labor 
Time Sheet or from the Labor Time Approval Page. See using PDF reporting from the Labor 
Time Sheet or PDF from the Labor Time Approval Page. PDF Time Sheets can also be 
created from the PDF Time Sheets Page.  

The PDF Time Sheets represent each employee’s written time sheet. 

1. Navigate to RP>Reporting>PDF Time Sheets 
2. Use the Filter  icon to filter the report by date ranges, Status, Jobs, Child Jobs 

and/or Pay Groups. 

3. Select Apply Filters. 
4. Select Settings using the Settings  icon to select any of the settings listed below 

for the report: 

5. Select Apply Settings.  
6. Select Generate Time Sheets.  
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7. The system will render and create a PDF Time Sheet for each employee in the 
search.  

Note: Employees may also be included using the check mark or excluded using the X. All 
employees may be included or excluded by toggling between Include All and Exclude All.   
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The Final Approval Before Exporting 

After reviewing time and checking for accuracy, the Payroll Manager conducts the final 
approval of the time. This is executed from the Labor Time Approval Page (RP>Track Labor 
Time>Time Approval). See Time Approval. 

If time has not been turned in the Payroll Manager can promote it to the Approved status. 
Once approved the status will indicate Reclaim. The Payroll Manager can reclaim it to 
make modifications up until the time of export. The job role (Levels) below the Payroll 
Manager will also see the Reclaim status but will not be able to make modifications unless 
they are at a level above in the Approval Path.  

Note: It is best practice to the lock the pay period prior to reviewing time, so others do not 
enter more time during the review and final approval process. See the Lock icon. If the user 
chooses not to lock prior to the review, it is best to at least lock it after export. That way any 
time accidentally added after the export will not continue to display and appear on 
reporting.   
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Step 4: Exporting Time to the Accounting System 
Time cannot be exported until time has been approved at the highest level in the Approval 
Path.  

1. Navigate to RP>Track Labor Time>Labor Export, or from RP>Track Labor 
Time>Time Approval.  

2. Select the Export  icon.  

3. Select Export Transactions.  
4. After Exporting, the Labor time will display in the accounting system.  
5. The status on the Labor Time Approval Page will change to Exported.  

Note: If time was not approved Export Transactions will be disabled and replaced with 
Nothing to Export on the Export Labor Page.  
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Accounting Sync 
Accounting Sync will synchronize data from the accounting system to hh2. Only users with 
permissions granted are allowed to perform a manual sync. Permissions are granted from 
the Home Page>Setup>User Setup>employee>Permissions tab>Can sync? It is 
recommended that the number of people that have this option is limited.  

Synchronization will automatically occur regularly. This option is to provide the Payroll 
Manager/Administrator with a means of bringing information from the accounting system if 
it has not yet been updated into hh2. Use Case: A new employee was not uploaded from 
the accounting system yet needed to add time prior to the next automatic synchronization.  

Navigation: Home Page> Your Company’s Data> Accounting Sync 
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To Run a Sync:  

1. Select the Filter  icon to filter the type of information to sync. The fewer records 
that need to be processed, the faster the synchronization will occur.  

2. Read the information on the Sync Filters Page to help determine the Date Range 
and Type of Sync (Shallow or Deep).  

3. Check the types of data to sync. Select All can be used to check all Data Types to 
Sync. The Sync by Search  icon can be used to further narrow the sync.  

4. Select Apply Settings. 
5. Select the Reconcile  icon to remove any categories in hh2 that have been 

deleted from the accounting system.  
6. Select Start Sync. 
7. Select the Help  icon for further information about Synchronization.  
8. All Entities Processed will display when the Synchronization is complete. However, 

there may be a brief time lag before the data can be seen.  
 

Notes about Synchronization:   

▪ Automatic synchronization typically occurs about every hour.  

▪ If an automatic synchronization is already in progress, the manual synchronization 
will take longer.  

▪ Once in process, synchronizations cannot be cancelled. 

▪ The Date Ranges and Data Types will limit the amount of data in the 
synchronization. It is important to not synchronize too much data at once.  

▪ Other work in hh2 can continue during a synchronization. 
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▪ It is recommended that users contact hh2 Support if a Deep Synchronization or 
synchronizing for all Date Ranges is being considered. 

▪ For Remote Payroll synchronization is one way from the ERP accounting system up 
to hh2. Downloads from the hh2 cloud to the ERP system do not occur for Remote 
Payroll.   
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Equipment 

Equipment Revenue 

Some construction companies choose to track how long equipment is used. The 
Equipment Revenue feature allows for this. This feature operates in very much the same 
manner as tracking time for employees. Instead of coding labor to an employee, employee 
time is copied to a piece of equipment for revenue tracking. Equipment Revenue will move 
through an Approval Path and ultimately exported, just like labor time.  

Equipment Revenue requires the Payroll Manager to have permissions (RP>Payroll 
Users>Username from the Payroll User Setup>Permissions> Check Is Eq. Manager). This 
permission provides the ability to manage equipment and export equipment time. By 
enabling this function for non-Payroll Managers, equipment time can be managed without 
having to contact the Payroll Manager. Note: This feature does NOT code an employee’s 
time against equipment (i.e., Equipment Cost).  

 

Equipment Set Up and Configuration 

✓ Equipment Set Up and Configuration requires the following: 
✓ Set up of the Master Equipment List 
✓ Enabling Equipment in the necessary Payroll Groups 
✓ Equipment Assignment to Employees 
✓ Revenue Code Enablement 
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The Master Equipment List for Equipment 

Payroll Managers with equipment permissions have access to the Master Equipment Setup 
(RP>Payroll Users and Groups>Equipment). This list syncs from the ERP system. 
Management of an equipment’s active vs inactive status, Payroll Group membership, 
and/or photo can be managed through this menu. Updates to the equipment’s code, name, 
type, and/or service status are recommended to be completed within the ERP to ensure a 
seamless export process. 
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To Add Equipment to the Master Equipment Setup List: 

1. Contact a hh2 representative to enable the capability to manually create 
Equipment. 

2. Navigate to the Home Page> Set Up>System Settings>General Settings tab> and 
check Create Equipment. 

3. Navigate to RP>Payroll Users and Groups>Equipment. 
4. Select the Add  icon.  

5. Enter the Equipment Code. 
6. Enter the Name of the equipment. 
7. Enter the Type of equipment (optional). 
8. Status (in service or out of service).  
9. Select Create Equipment. 
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Payroll Groups and Equipment 

Navigation:  RP>Payroll Users and Groups>Payroll Groups 

Just like Labor time, Equipment time is driven by a Payroll Group. As with Labor, the Payroll 
Group provides users access to certain equipment for coding time to the equipment. 
Access to coding to equipment is defined in the Payroll Group Setup (RP>Payroll Users 
and Groups>Payroll Groups>specific Payroll Group on Payroll Group Setup>Settings 
tab>Equipment=Enabled). This will display the Equipment tab in the Payroll Group Setup.  

  



Version 2 030424 hh2 User Guide-Remote Payroll-Manager Role  Page 101 of 171 

When selected, the Equipment tab lists all equipment in the Master Equipment List. Here 
the Payroll Manager can Add or Remove any equipment that the Payroll Group should or 
should not have access to for coding.  
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To Add Equipment from a Payroll Group: 

1. Navigate to RP>Payroll Users and Groups> Payroll Groups. 
2. Select the Payroll Group. 
3. Select the Equipment tab.  

4. Select the Add  icon next to the equipment to be added. Select Assign All to add 
all equipment from the Payroll Group.  

5. Equipment added will then be displayed beneath the Assigned Equipment section 
for the Payroll Group.  
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To Remove Equipment from a Payroll Group: 

1. Navigate to RP>Payroll Users and Groups> Payroll Groups. 
2. Select the Payroll Group. 
3. Select the Equipment tab.  

4. Select the Remove  icon next to the equipment to be removed. Select Remove 
All to remove all equipment from the Payroll Group.   
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Equipment Assignment to an Employee 

To Assign a Piece of Equipment to a Single Employee: 

Use Case:  An employee consistently uses a company truck throughout their day and thus 
the truck’s time will be replicative of the employee’s time. 
 

1. Navigate to the Payroll Employee Setup (RP>Payroll Users and 
Groups>Employees>select the employee>Equipment tab). 

2. Select the Add   icon next to the equipment in the Not Assigned Section. 
3. The Equipment will then be displayed below Assigned Equipment, and the 

employees will be permitted to code time to it.  
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Revenue Code Enablement 

Revenue Codes define the rate (hourly, daily, or weekly) to which a piece of equipment will 
be coded. This code is used by the accounting system and its use is dependent upon the 
accounting system used. It is enabled in the Payroll Group Setup Page. When enabled, the 
revenue code will appear on the Equipment Time Sheet.  

1. Navigate to RP>Payroll Users and Groups>Payroll Group Setup>select the Payroll 
Group>Settings tab> Revenue Code. 

2. Select from the following: 

▪ Disable: Revenue codes are not used 

▪ Enabled: Revenue codes can be used but are not required.  

▪ Required: Revenue codes are required 

▪ Required with Equipment: Revenue codes are required when coding to equipment. 

 

Note: When the Revenue Codes field is set to required, the user will be prompted for a 
revenue code when keying time for equipment.  

Note: The Revenue Code field is an optional coding field that can be utilized within hh2. If 
the accounting system has default revenue codes setup on the equipment items and those 
will not be changing, then revenue codes do not need to be used in hh2.  
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Equipment Revenue Time Sheet 

The equipment time sheet functions just like the Labor Time Sheet. The purpose of the 
Equipment Revenue Time Sheet is to code time against a piece of equipment.  

Navigation: RP>Equipment Revenue>Equipment Time Sheet. 

The Equipment Revenue Time Sheet Page allows searches by: 

▪ Payroll Group 

▪ Equipment 

▪ Pay Period 

On the Equipment Revenue Time Sheet Page, the Payroll Manager can also toggle between 

Weekly and Daily views using the Weekly  icon in the upper left corner. Daily views are 
considered a shared view, and the user can see more than one piece of equipment.  

Note:  Equipment Revenue Time may also be copied from the Labor Time Sheet. See To 
Add Time to Equipment Revenue.  
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Tools on the Equipment Revenue Time Sheet 

Like the  Labor Time Sheet, there are tools on the Equipment Revenue Time Sheet. When 
More… at the top of the Equipment Revenue Time Sheet  is selected, a variety of other 
tools appear for use on the Equipment Revenue Time Sheet Page.  

One of these tools can be displayed outside the More button based on the User Preference 
set in the User Settings (RP>Equipment Revenue> Equipment Time Sheet> 
More…>Settings  icon>Primary Button. 
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Refresh: This icon will refresh the time sheet data.  

Refresh: This icon will refresh the equipment revenue time sheet data.  

Time: Allows the user to add a time record to the equipment.  

To Add Time Using the Time  icon on the Equipment Revenue Time Sheet Page: 

Note: This provides an alternative method to enter time instead of keying it directly onto 
the Equipment Revenue Time Sheet Page.  

1. Select More…at the top of the Equipment Revenue Time Sheet Page. 
2. Select the Time  icon.  
3. Enter the Equipment or use the search to find the equipment.  
4. Enter the Date. 
5. Enter the Units (of time). 
6. Enter any additional information needed (a description, Job, Cost Code, Category 

Coding). 
7. Check Coding to add coding to the time sheet.  
8. Select Save Time.   
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Look: Allows the user to view all the time entered for the equipment.  

Note: The Approval Log may be accessed from the View All Time Page. The Approval Log 
allows the user to see who has approved the Equipment’s time and when. It is not a full 
audit of the Equipment’s history. 

Excel: Creates an Excel spreadsheet with the equipment’s time. It must be downloaded to 
view.  

Help:  Takes the user to related Knowledge Base articles.   
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Additional Tools on the Equipment Revenue Time Sheet 

Just like the Labor Time Sheet, the Equipment Revenue Time Sheet has additional tools. 
However, here they apply to equipment time versus labor time. These tools are accessed 
from More… adjacent to the days of the week on the Weekly View or the employee names 
on the Daily view. They function similarly to the same tools found on the Labor Time Sheet. 
Copy, Promote, Deny and Reclaim are used during the Workflow step of Remote Payroll. 
These functions are utilized in the same manner for both Equipment and Labor time. See 
Additional Tools on the Labor Time Sheet. 
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To Add Time to the Equipment Revenue Time Sheet Page: 

 

1. Navigation: RP>Equipment Revenue>Equipment Time Sheet. 
2. Select Weekly or Daily in the upper left corner.  
3. Select the Payroll Group. 
4. Select the Equipment 
5. Select the Pay Period. 
6. Select Add Jobs/Codes to Time Sheet. 
7. Select the Job. 
8. Select Cost Code  
9. Select Add Selected Items. 

10. Select Add to Time Sheet. 
11. The coding line will now display with the newly added Job and Cost Code. Likewise, 

the Job Explorer   , Approval  and Delete   icons will now display.  
12. Select a box aligned with the date and coding where time should be entered.  
13. Enter the numerical value for the amount of time coded to the Equipment.  

 

The Comments  icon: Employees or managers can enter a daily comment on the 
Equipment Revenue Time Sheet. When a comment is added on the Equipment Revenue 
Time Sheet, it will display on the Equipment Time Approval Page. 
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Equipment Time Record Entry 

Navigation: RP>Equipment Revenue>Time Record Entry 

The Time Record Entry Page provides an alternative means for entering equipment time. It 
displays in a list view rather than a spreadsheet view.  

Like the Equipment Revenue Time Sheet, the Payroll Group, Pay Period, and Equipment 
display.   
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Tools on the Equipment Time Record Entry 

Auto-Fill: For ease and speedy time entry, the auto-fill feature populates the Equipment 
Time Record Entry with the previous pay period’s time.  

To Use Auto-Fill: 

1. Select the Auto-Fill  icon.  

2. Select OK. When OK is selected, the previous pay period’s time will fill the 
Equipment Time Record Entry Sheet with the previous pay period’s time against the 
equipment.  

Likewise, the Time Entry Settings Page (for equipment) function like the User Settings on 
the Labor Time Sheet. The user can add and delete time from the Time Record Entry Page 
(for equipment), in the same manner as on the Labor Time Sheet. See To Add Time Using 
the Time icon on the Equipment Revenue Page.  
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To Delete Time from the Time Record Entry Page: 

1. Select the Delete  icon. This enables Delete  icons next to each time line item.  

2. Select the Delete  icon for each line item to delete. This will remove the time.   
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Equipment Workflow 

Just like Labor Time, Equipment time follows the Approval Path specified for the Payroll 
Group (RP>Payroll Users and Groups>Payroll Groups>specific Payroll Group>Approval 
Path tab). Note: The Approval Paths are set up by user role. Likewise, the Approval Path is 
structured by levels. These are customizable to meet the preferences and needs of the 
construction company. See Step 2 Workflow (Approval Path). 

Equipment Time can be copied from Labor. It may also be Promoted, Approved and 
Reclaimed from the Equipment Time Approval Page, just like labor is from the Labor Time 
Approval Page. See Labor Time Approval Page. 

Navigation: RP>Equipment Revenue>Equipment Time>Equipment Time Approval 

Note: The Equipment. Revenue entered on the timecard for the employee is a tool to 
quickly copy the employee’s time and code to the equipment’s time sheet. So rather than 
having to manually enter the same time in both places users only enter the equipment time  
for the employee and can copy it to the equipment. 

 

To Copy All Labor Time to Equipment Revenue based on Employee Default Equipment: 

1. Navigate to the  Equipment Time Approval Page. 

2. Select the Copy Labor  icon. 

3. Select Ok.  
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Exporting Equipment Time 

Navigation: RP>Equipment Revenue> Equipment Time Export 

1. Just like time for labor, all time must be approved for the equipment time prior to 
exporting to the accounting system. All time that is approved will be displayed with 

the green Reclaim  icon.  

2. Select the Export  icon. The Export  icon can also be accessed through 
RP>Equipment Time Approval.  
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3. The Export Equipment Revenue Page will be displayed with a preview of the export.  

4. Double check dates. 
5. Select Export 1 Equipment. 

6. The export display results. If the export fails, click the History  icon to view the 
Equipment Export Log to review the failure. 
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7. After Exporting, the Equipment time will display in the accounting system.  

 

Note: While Labor exports cannot be undone (with the exception of a few accounting 

systems), Equipment exports can be undone, using the Undo  icon on the Equipment 
Export Log Page.  

Note: If there is a plan to undo an export, first ensure to remove any imported data within 
the accounting system first before re-doing the export. This will reduce the risk of duplicate 
data being created within the accounting system. It is recommended that the user contact 
hh2 for assistance in this matter.   
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Punches and Attendance 

Punch Clock 
This feature provides the construction company with the ability to have employees punch 
time in and out. This feature is not to be confused with the legacy Attendance Punch Clock 
feature which does not capture coding information. The new Punch Clock feature captures 
coding information. Punch Clock time, just like labor and equipment, will be routed 
through an Approval Path and ultimately exported to the accounting system.  

 

Punch Clock Set Up and Configuration 
The Punch Clock feature must be enabled in order for it to function. There are four steps in 
the set up for Punch Clock: 

1. Enable the Punch Clock Feature 
2. Select options for rounding and capturing GPS coordinates and photos. 
3. Turn on the Punch Clock for individual Payroll Groups and select defaults 
4. Grant Permissions in the Approval Path for the Payroll Group.  
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Punch Clock Enablement 

To Enable the Punch Clock Feature:  

1. Navigation to RP>Settings>System Settings>General Settings tab>check Use 
Punch Clock. Note: This can only be executed by the hh2 Administrator. If this 
setting has not yet been enabled, please contact the hh2 support team for 
assistance.  

2. Check Use Punch Clock to enable it.  
3. Refresh the page. Once refreshed Punch Clock will be added to the list of tabs.  
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Punch Clock Options 

 To Select the Punch Clock Options: 

There are three options in the Punch Clock tab (Punch Clock Rounding, Capture GPS, and 
Capture Photo): 

1. Navigate to RP>Settings>System Settings>Punch Clock tab. 
2. Select from the following options: 

▪ Punch Clock Rounding (Minute, Quarter-hour, Half-hour, Full-Hour). This setting 
determines to what degree punches are rounded. This setting’s default is set to 
round to the nearest minute. Use the Picklist to select time rounding. 

▪ Capture GPS (captures the coordinates of where the punch was made).To enable 
the capturing of GPS coordinates, check the box next to Capture GPS. Note: This is 
not Geo-fencing. This feature only captures the coordinates of the employee at the 
time of punching in or out.  

▪ Capture Photo (captures the employee’s photo upon punching time-this feature is 
not required). To enable capturing of the employee’s photo, check the box next to 
Capture Photo. 
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Punch Clock Payroll Groups Set Up 

To Turn on the Punch Clock for Payroll Groups: 

The Punch Clock feature can be enabled for select Payroll Groups. This provides the 
construction company with the ability to limit which Payroll Groups utilize the Punch Clock. 
For instance, salaried employees can be set up in a separate Payroll Group from those 
employees that require time to be punched.  

1. Navigate to RP>Payroll Users and Groups>Payroll Groups. 
2. Select the specific Payroll Group. 

3. Select the Settings tab. 
4. Check Punch Clock. Note: Attendance Punch Clock and Attendance Punch Clock-

Shift/Break Times are related to the legacy Attendance Punch Clock feature. A 
Payroll Group cannot have both Punch Clock and Attendance Punch Clock 
checked. It must be one or the other.   
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5. Select the Punch Clock tab.  

6. Next, Apply Coding Defaults. These fields allow for default codes to be selected. 
Defaults can be set for the Pay Type, Job, Standard Cost Code, Standard Category, 
GL Account, and/or Department as needed. Once a default code has been selected, 
when an employee within the group punches in or out, they will be provided with the 
default code which can be overwritten to ensure accuracy. By selecting default 
codes, employees will not need to select repetitive codes each time they make a 
punch. For example, selecting Regular for the Pay Type coding selection will not be 
necessary upon punch. Enter the Pay Type, Job, and applicable Standard Cost 
Code, Standard Category, GL Account and Department, as needed. 

7. Select Save Payroll Group Settings.  
8. A message will indicate the Payroll Group defaults have been successfully saved.   
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To Grant Punch Clock Permissions in the Approval Path for the Payroll Group: 

This feature provides the ability to grant users within this group with various permissions 
pertaining to the Punch Clock and Time Approval systems. This includes or excludes users 
from the following abilities: 
 

▪ Enter/Edit Time-for Non Punch Clock (not applicable here) 

▪ Approve Time-for Non Punch Clock (not applicable here) 

▪ Reclaim Time-for Non Punch Clock (not applicable here) 

▪ Edit Attendance-for Non Punch Clock (not applicable here) 

▪ (PC) Edit Punch Times-grants the ability to edit a punch’s time and/or time zone 

▪ (PC) Punch for Others-grants the ability to use kiosk mode within the mobile 
application and access the Crew Punch Page. 

▪ (PC) Add Manual Punches-grants the ability to create punches manually rather than 
in the moment as a live punch.  

▪ (PC) Edit Coding (allows changes to the coding, but not the time itself) *PC 
indicates Punch Clock Permissions versus time itself. 
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This feature offers the construction company a safety measure to ensure employees in the 
Approval Path cannot edit their own time. Use Case: To prevent an employee who arrived 
to work late from editing their own time.  

1. Navigate to RP>Payroll Users and Groups>Payroll Groups 
2. Select the specific Payroll Group 
3. Select the Approval Path tab. 

4. Click below the Job role in the Level where it says, Permissions…. This will take the 
user to the Edit Approval Level Page where permissions can be granted or revoked 
for users within the selected role. 

5. Check the permissions to grant for this Level and Type (on the right). 
6. The Level and Level Type fields are used when setting up a new approval level in an 

Approval Path. Those fields will already be set up prior to granting permissions.  
7. Select Update Level.  
8. Select the Approval Path tab in the Payroll Group and select Save Approval Path for 

the permissions to be saved. This MUST occur or the permissions will not be saved.  
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Note: User roles at the higher levels would benefit from having additional permissions, so 
those users, such as supervisors, have permission to edit punch time. When managers 
punch time for the employees or a group of employees it is referred to as Crew Punch Clock 
in hh2. See Crew Punch Clock.  
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Punching In and Out 

Punching Time on the Punch Clock (by employee) on the Web 

To Punch Time on the Web (by employee): 

1. Navigate to RP>Punches and Attendance>Punch Clock. 
2. The employee’s name and default Payroll Group will be displayed on the Punch 

Clock. If an employee is part of more than one Payroll Group, they will need to select 
which Payroll Group to punch time. An employee cannot select another employee’s 
name on Punch Clock. The current date and time will be displayed at the top of the 
Punch Clock.  

3. Select Punch In to punch in.  
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4. The Add Coding to Punch Page will display.  

5. Select the appropriate coding on the Add Coding to Punch Page for Pay Type, and 
other coding enabled for the Payroll Group. Note: Pay Type will always be required, 
however other coding fields are dependent upon being enabled in the Payroll Group. 

6. Select Add Coding.  
7. A brief message displays indicating the Punch In was recorded.  

8. On the right, the punch displays. It also shows a missing punch, since the employee 

has not yet punched out for lunch or for the day. The Change Coding   and 

Comments  icons now appear.  

Note: There must be a minimum of 60 seconds between the capturing of punches. If 
punches are made prior to that time, Punch In, Change Coding, and Punch Out will lock 
and remain locked until the 60 seconds have passed.  
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The Change Coding  icon allows the employee to punch in a new set of coding. Upon 
performing Change Coding, the employee will be punched out of their current coding and 
punched into new coding provided the steps are correctly followed. Coding can only be 
edited during Punch In, not Punch Out. Use Case: An employee moves to a different job.  

To Change Coding:  

1. Select the Change Coding  icon in the middle of the Punch Clock. 

2. Select the new coding for each appropriate field. 
3. Select Change Coding. 
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The Comments  icon allows the employee to enter a comment about the day’s events 
related to time. For instance, if the employee was late, or leaving for an appointment. Note: 
This same functionality is used on the Labor Time Sheet.  

 

To Enter Comments: 

1. Select the Comments  icon. 

2. Enter the Comment 
3. Select Save Comments.   
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To Punch Out: 

1. Navigate to RP>Punches and Attendance>Punch Clock. 
2. The employee’s name and default Payroll Group will be displayed on the Punch 

Clock. If an employee is part of more than one Payroll Group, they will need to select 
which Payroll Group to punch time. An employee cannot select another employee’s 
name on Punch Clock. The current date and time will be displayed at the top of the 
Punch Clock. 

3. Select Punch Out.  
4. The Punch Out time will display on the right side of the page.  
5. Once a Punch In and Punch Out record has been captured, the interval of time 

between the two records will display on the Labor Time Sheet in either the Weekly or 
Daily View (RP>Track Labor Time>Time Sheet>specific Payroll Group>specific 
employee. Note: The total punch interval will be displayed near the date (Weekly 
View) or name (Daily View) at the top in color. 
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The Edit Punches Page 

When the total Punch Clock Units (displayed in color) are selected from the Labor Time 
Sheet (RP>Track Labor Time>Time Sheet), the Edit Punches Page will open. This page 
shows each punch record and interval duration captured for the selected week.  

Within the Edit Punch Page, the user can view a punch record’s history, edit a punch 
record’s time or coding, delete a punch record, or manually add missing punch records. 

Note: This page may also be accessed from the Labor Time Approval Page, using the 

Attendance  icon.   
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To View the Time Punch History: 

1. Select the History  icon from the Edit Punches Page. 

2. The Punch History displays. Note: Each historical step will display the user who 
performed the action, the date and time the action occurred, and where the action 
was performed. Additional details regarding the action, such as the manner in which 
the coding occurred are also available.   
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 To Edit Punch Information:  

1. Select the Edit  icon from the Edit Punches Page.  

2. Click on the appropriate field(s) to edit and make modifications. Note: When the 
Direction (In) is selected with a click, the user can update coding by selecting 
Update Coding on the Edit Punch Page. When Update Coding is selected, the Edit 
Coding Page then displays. 

3. To update coding, make the appropriate selections on the Edit Coding Page and 
select Submit Coding. Otherwise, select Update Punch from the Edit Punch Page.  

4. The Time Punch will update.  
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To Add Missing Time: 

1. When time is missing from a Time Punch, the Add  icon will display on the Edit 
Punches Page. 

2. Select the Add  icon.  

3. Select the Date. 
4. Enter the time on the Add New Punch Page. 
5. Select the Direction. 
6. Select Create New Punch. 
7. Select Coding to the punch on the Add Coding to Punch Page. 
8. Select Add Coding.  
9. The punch will appear on the Labor Time Sheet once a punch in and out interval 

occurs.  



Version 2 030424 hh2 User Guide-Remote Payroll-Manager Role  Page 136 of 171 

To Delete a Punch: 

1. Select the X next to the Time Punch on the Edit Punches Page. 

2. Select Yes. 
3. The time will be removed from the Labor Time Sheet. 

Note: The Punch Clock feature captures the coding information on the Labor Time Sheet. 
Whereas the legacy Attendance Punch Clock product does not capture coding information 
and it will need to be allocated to the proper job and cost code manually on the Labor Time 
Sheet. Attendance Punch Clock is simply punching time in and out.   
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Crew Punch Clock 
A field manager typically uses Crew Punch to punch time for a group of employees. The 
manager can select which Payroll Group to punch time for and has the capability to punch 
all employees within a Payroll Group at once. Managers may also deselect employees that 
are not in attendance prior to punching the Payroll Group’s time. Managers also have the 
flexibility to punch employees into different jobs, pay types, general ledger accounts and 
certified classes (if applicable).  

Navigation:  RP>Punches and Attendance>Crew Punch Clock 

When the Manager navigates to the Crew Punch Clock, this is how the Crew Punch Clock 
Page will appear prior to punching time for the Payroll Group. 
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To Punch a Payroll Group In: 

1. Navigate to RP>Punches and Attendance>Crew Punch Clock. 
2. Click on the Payroll Group. 
3. Select the Payroll Group.  

4. The employees for that Payroll Group will load on the Crew Punch Clock.  

5. The Punched Out status tab will be automatically selected. This tab displays all 
employees currently Punched Out and awaiting to be Punched In.  

6. Select all Employees with the Select All   icon. The Punched Out status tab will 
be automatically selected.  

7. Select Punch In. This will Punch In all employees that were selected. Punches will 
be displayed on the right hand portion of the page. The downward arrow adjacent to 
the employee’s name allows the user to view the punches in greater detail.   
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Note: Use the Deselect  icon, to deselect all employees in the Payroll Group. Managers 
may also select certain employees, with a click. The employee’s line item will display in 
white. To deselect an employee, click on the employee again. Their line items will now be 
displayed in green. Users can toggle Punch In/Punched Out adjacent to Employee Status 
to view employees that are Punched In versus Punched Out.   
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To Punch One or Several Employees to a Different Job, Cost Code, Pay Type, GL Account 
or Certified Class:  

1. Navigate to RP>Punches and Attendance>Crew Punch Clock. 
2. Click on the Payroll Group. 
3. Select the Payroll Group from the Select Payroll Group Page.  

4. The employees for that Payroll Group will load on the Crew Punch Clock.  

5. Select all Employees with the Select All   icon.  
6. Click on the employee(s) that will require changes to Job, Cost Code, Pay Type, GL 

Account or Certified Class. This will deselect them and their line item will display in 
white. Whereas the remaining selected employees will display in green.  

7. Select Punch In to punch the selected employees (in green). The Add Coding to 
Punches Page will display. 
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9. Enter the necessary information. 
10. Select Add Coding.  

11. For the deselected employee(s) (in white), the manager may select one employee at 
a time or all at once with a click. The click will cause the employee to be selected 
and will be displayed in green.  

12. Select Punch In. 
13. Modify the Pay Type, Job, Cost Code, General Ledger Account or Certified Class 

fields as needed. The X will deselect unnecessary fields.  
14. Select Add Coding.  

Note: When on the Punch In status, a new icon will appear between Punch In and Punch 
Out. This will also open the Add Coding to Punches Page. However, upon clicking the Add 
Coding icon, all selected employees will be punched out from their old coding (such as Job 
and Cost Code for instance) and punch them into their new coding.  
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To Punch Out: 

1. Navigate to RP>Punches and Attendance>Crew Punch Clock. 
2. Click on the Payroll Group. 
3. Select the Payroll Group.  

4. The employees for that Payroll Group will load on the Crew Punch Clock. If not, 
toggle to the Employee Status of Punched In. 

5. Select all Employees with the Select All  icon.  
6. Select Punch Out. Just like Punch In, employees may be deselected with a click. 

This will cause their line items to display in white and exclude them from the Punch 
Out.   
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Punch Management 

The purpose of the Punch Management Page is designed for Payroll Managers who want to 
add and/or edit multiple employee punches at one time (in bulk). Use Case: There are ten 
employees who forgot to punch out and the Payroll Manager needs to punch them out.  

Navigation: RP>Punches and Attendance>Punch Management 
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Punch Management System Setup and Configuration 

Two settings must be selected to enable Punch Management: 

Note: These settings must be enabled by the hh2 Administrator.  

1. Punch Clock must be enabled in the RP>Settings>System Settings. See To Enable 
the Punch Clock the Punch Clock Feature. 

2. Home Page>Set Up>System Settings>Feature Flags>Check Punch Management.  
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The Punch Management Page 

Navigate to RP>Punches and Attendance>Punch Management. 

▪ Punch Management is designed for users to work with either employees or punch 
intervals, but not both at once.  

▪ The Action bars on the left (Add Punch, Delete) represent Action bars for 
employees, while the Action bars on the right (Edit and Delete) represent Action 
bars for time intervals.  

▪ Total time is next to each employee’s name. Zero next to an employee’s name 
indicates the punch interval has not yet been completed.  

▪ Time intervals may be selected with a left click and deselected by clicking again.  

▪ Use Clear Selection to unselect all.  

▪ The Date Field in the upper left corner allows the user to select a month by clicking 
the date. Or using < and > the user may toggle with back or forward with individual 
dates.   
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Using the Punch Page 

1. From the Payroll Group field, select a Payroll Group by clicking on Magnifying  
icon. 

2. Select the Payroll Group. 
3. The employees for that Payroll Group will be displayed on the Punch Management 

Page.  
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To Add a Punch: 

1. Select an employee or multiple employees by checking the box next to their name, 
or all employees by checking the box next to Name.  

2. Add Punch and Delete will highlight on the left side of the Punch Management 
Page.  

3. Select Add Punch. 

4. Check the Start and/or End box(es). Enter Time Intervals, as needed.  
5. Select AM or PM. 
6. Select Next Step. 
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7. Enter Coding.  
8. Select Next Step.  

9. Select Confirm. 
10. The Time Interval for the employee(s) will be displayed on the Punch Management 

Page.  
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To Edit Time Intervals: 

1. One or more Time Intervals may be edited at once. However, the primary purpose of 
Punch Management is to work with punches in bulk. 

2. Select the Time Intervals to edit with a click. They will display in orange. A double 
click will immediately display the Edit Multiple Punches Page.  

3. Edit and Delete on the right side will highlight.  
4. Select Edit.  

Note: If there is a range of punches, the earliest and latest punch interval times will display 
if there are multiple punches selected.  
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5. Check the Start and End Time boxes, make necessary modifications to time, select 
AM or PM,  then select Next Step. If edits need to be made to coding, select Next 
Step. 

6. Modify coding as needed. Click the associated coding field to change the coding. 
Note: If punches are on different Jobs, “Preserve Current Value” will be displayed in 
the Job field. When Next Step is selected the current (different) Jobs will be 
preserved. Or Jobs may be changed by clicking on the Job field.  

7. Select Next Step. 

8. Select Confirm.  
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To Delete Punches: 

1. Unselect any employees with Clear Selection.  
2. Select the Time Intervals to delete with a click. 
3. Select Delete in the upper right corner.  

4. Select Yes, delete them. 
5. The Time Intervals will be deleted and the Total Time next to the employee(s)’s 

whose intervals were deleted will read zero.  
 

To Delete All Punches for a Single Employee: 

1. Clear Selection. 
2. Add Punch and Delete will highlight in the column above the employee list.  

3. Select Delete. 
4. Select Yes, delete them.  
5. All Time Intervals for the selected employee(s) will be deleted.  

 

Punch Card Summary: Once a complete punch interval is made through the capturing of a 
Punch In and Punch Out record with coding via the Punch Clock or Crew Punch, the 
interval of time will automatically be entered on the employee’s Labor Time Sheet and 
move through the designated Approval Path for the Payroll Group. Time can be reviewed, 
like time entered via any other means on the Labor Time Approval Page by the Payroll 
Manager. It is then  ultimately exported to the accounting system.   
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Attendance Punch Clock 
This feature allows for geo-fencing but does not capture any coding. This feature provides 
the construction company with the ability to only have employees punch time in and out. 
Attendance Punch Clock is not to be confused with the Punch Clock feature which does 
capture coding information. Attendance Punch Clock time captures time for a Payroll 
Manager or Administrator to view.  

Navigation: RP>Punches and Attendance>Attendance Punch Clock. 
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To Punch In or Out Using the Attendance Punch Clock: 

1. Select the Employee Name from Select Who You Are. 

2. Select Punch In and Punch Out.  
3. Breaks may be selected. 
4. Notice there is no coding.   
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Attendance Worksheet 

The Attendance Worksheet is designed for batch entry of time using the Attendance Punch 
Clock feature. A manager can add or edit punches in bulk.  

Navigation: RP>Punches and Attendance>Attendance Worksheet. 

To Add Time in Batch: 

1. Select the Payroll Group. 
2. Select the Date.  
3. Select the Employees add time to either with a click or Select All Rows, when adding 

time to all employees.  
4. Enter the Shift Star time, check for Breaks, select Lunch start and end and select 

Shift End time. Tab to each field.  
5. Select Apply to apply time to the employees selected.  
6. The percentage of hours is the percentage of employees selected within the Payroll 

Group.  

 
Notes: 

▪ The Finalize   icon will commit the time to Payroll Time. 

▪ The Punches  icon allows the user to view and edit punches. 

▪ The Favorites   icon will remember the current batch values as defaults. 

▪ The Settings  icon will set Punch Clock settings for the user.   
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Mobile Apps 
The hh2 RP mobile app can be downloaded for Apple iOS iPhone and iPad, as well as the 
Android Phone and tablet. Field users typically use the mobile application. See the RP 
Mobile App User Guide for Field Users.  

 

Summary 
The hh2 Remote Payroll system is structured around a streamlined four-step process. It 
begins with field users entering their time through a user-friendly web interface or a 
dedicated mobile application. Following this, a meticulously designed workflow initiates, 
involving approval from designated members of the Approval Path for the Payroll Group. 
The process advances with a comprehensive review and final approval conducted by the 
Payroll Manager. Ultimately, the approved time seamlessly integrates into the accounting 
system, marking the completion of the process. The Remote Payroll module is versatile, 
accommodating both non-punch time and punched time, with the added functionality to 
track equipment time effectively. 

 

Please feel free to submit any comments, or issues regarding this documentation to 
documentation@hh2.com 

 

 

mailto:documentation@hh2.com
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Glossary of Terms 
Note: This includes terminology for all hh2 modules as well as some industry language. 

AB Locations: This term is utilized in the hh2 HR module. AB (Address Book) Locations  
can be used to assign an employee to a particular location. For instance, a home office or 
state location.  

Acceptance Group: In the document Acceptance step in the Document Flow (AP) module, 
multiple Acceptance Groups can be set up so that larger companies can divide new 
invoices into groups for more orderly processes. This is frequently done when the company 
has multiple physical office locations, multiple business entities, or multiple divisions 
within the company. Using Acceptance Groups, AP Clerks can process invoices for their 
own office, entity, or division and not get documents outside their jurisdiction. 

Accounting System: For the purposes of this document, the accounting system is the 
construction company’s Enterprise Resource Planning System. See ERP. 

Accrual: This term is used in the HR, Remote Payroll and Pay Stubs modules. It refers to 
the accumulation or gradual increase of benefits or earned time off over a specific period, 
typically based on the length of an employee's service or time worked. 

Admin or Administrator: An employee at a construction company that has a high level of 
permissions within the hh2 system. This individual can create users and set permissions for 
users. Likewise, this individual can configure certain portions of the hh2 system. This 
person is different from both the hh2 Admin and the System Administrator. See hh2 
Admin. 

AP Clerk: An AP Clerk is a user at the construction company that has permissions to 
perform some aspect of the invoice processing within hh2 Document Flow. Permissions 
can be set up to allow or deny AP Clerks access to portions of the software. This allows hh2 
customers to configure AP Clerk permissions around their unique needs. 

AP Group: This term is used in the Document Flow module. AP Groups are set up so that 
users can be given permissions based on the roles that they fill within the company. For 
example, an hh2 customer might set up a Field Supervision group and add all foremen and 
superintendents to it, so they only need to grant access to the accounting codes once.  
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AP Manager: This individual is someone at the construction company that has high levels 
of access and permissions within hh2 Document Flow. They oversee the processes of 
managing recipients, reimbursements, and invoices. 

AP Page: This is the landing page of the hh2 system’s Document Flow (AP Module). The 
AP Page is where the user can access features and functionality of the Document Flow 
Module. Each user’s AP landing page will display based on the permissions granted to 
them. Note: The terms AP and Document Flow are used interchangeably within the hh2 
system. See Document Flow. 

Approval Path: In the Remote Payroll module, the Approval Path is configured based on 
the construction company’s needs and preferences, dictating the flow of time approval. 
The Approval Path can be established according to employee levels, group manager roles, 
or job manager roles. It is also structured in levels. 

Attendance Punch Clock: In the Remote Payroll module, the Attendance Punch Clock 
captures time for Payroll Managers or Administrators to review. Coding is not captured with 
this feature. This should not be confused with the Punch Clock feature, which does capture 
coding.  

Bank: The Financial Institution the construction company processes their credit card 
transactions through 

Batch: Processing more than one piece of data at a time. This term typically refers to large 
numbers of invoices, receipts, or other financial instruments and time managed by hh2. 

Cardholder: This term is used in the Document Flow (AP) module. This is the individual 
whom the credit card is assigned to in the Document Flow User Setup. This is also the 
person using the credit card for purchases, and who will upload the credit card receipts 
into hh2. Note: AP Administrators and AP Managers may also upload credit card receipts 
for the cardholder.  

Categories: Some accounting systems have a customizable layer between Cost Codes and 
Cost Types. This enables a contractor to distinguish between multiple categories of the 
same Cost Type. For example, there might be two labor categories that accumulate to the 
Labor Cost Type, one for regular labor, one for overtime. A Contractor may budget for this 
ahead of time if they know the job will be on a tight deadline. 

Certified Work: Work that the government guarantees an assured wage for certain types of 
work (by Certified Class) for government Jobs. Examples of such Jobs may include work on 
schools, highways, or government buildings. Other interchangeable terms include Davis 
Bacon or Prevailing Wage Work.  
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Child: In construction and business, structures often follow a hierarchical format, which 
means they are organized in a clear and structured manner with parent and child 
relationships. In the business realm, this can be observed in the presence of subsidiary 
companies operating under a larger parent company. Similarly, in data management, 
certain abstract concepts are categorized as child entities under a larger entity. For 
example, in construction projects, Extras or Sub Jobs can be considered as child entities of 
a more comprehensive Job. Furthermore, Cost Codes may serve as child entities tied to the 
specific Job. The term "Parent" is used to denote the larger, overarching entity in these 
hierarchical structures. Also see Parent. 

Commitment: In hh2, this term is often used interchangeably with "Purchase Order." It is 
an official document issued by a General Contractor to a Subcontractor or Supplier 
outlining the specifics of the commitment to perform labor or purchase materials. 
Commitment Items will include specifics like quantities, prices, and delivery terms.  

Cost Code: Also referred to as “Phase Codes,” Cost Codes are used as part of a Job Cost 
system to track the costs of a Job. In construction, many companies opt to use the 
standardized CSI Divisions as cost codes. For example, the CSI Division for Concrete is 
“03” and the Section for Decks is “500”, so the cost code of “03-500” is for Concrete 
Decks. The fundamental purpose of cost codes is to track all job-related expenses in an 
orderly fashion that is consistent across all jobs, enabling complex cost management, 
reporting, and analysis. 

Cost Types: Cost Types accumulate expenses under cost codes and categories using fixed 
types of costs. Common examples of Cost Types include Labor, Materials, Equipment, 
Overhead, Subcontract, and Misc/Other. Some construction ERPs allow partial 
customization of Cost Types instead of supporting Categories. When Categories are used 
for coding, there is no need to use Cost Types as all categories have a fixed Cost Type. 

Credit Card Transactions: This term is used in the Document Flow (AP) module. It is a 
financial transaction in which a cardholder uses their credit card to make a purchase or 
payment, with the promise to repay the card issuer later. In hh2, the AP Administrator or 
AP Manager will upload these transactions from the bank into hh2 and the system will 
match them with receipts uploaded by the cardholder.  

Crew Punch: In the Remote Payroll module, the Crew Punch feature allows a manager to 
punch all employees, designated to a certain Payroll Group, in or out at once.  

CVS (Comma-Separated Values) File:  A plain text file format used to store and exchange 
structured data, where each line represents a record, and fields within each record are 
separated by commas. This term is used in the Document Flow (AP) module. 
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Daily Logs/Field Reports: Within the Field Reports module, these terms are used 
interchangeably to reference construction logs that allow for reporting of a variety of 
variables on or off the job site. 

Data Entry: This term is used in the Document Flow (AP) module. In hh2, Data Entry is the 
second step in the Document Flow-Invoice Process. It includes reviewing the Invoice, and 
coding data into the Header and entering full or partial Distributions. Typically, Data Entry 
is performed by AP staff before sending the invoice down the customizable Workflow. 
Much of the Header can be automated by using OCR and Autofill features of hh2 
Document Flow. Often, the distribution coding during Data Entry is limited to just assigning 
a Job, and the detailed distribution coding is done during the workflow process by those 
assigned to manage the Job, such as a Superintendent or Foreman for smaller Jobs. The 
last step of Data Entry is choosing which workflow that should be used for approval or 
rejection if the default needs to be overridden. 

Davis Bacon: Work where the government guarantees an assured wage for certain types of 
work (by Certified Class) on government. Examples of such Jobs may include work on 
schools, highways, or government buildings. Other interchangeable terms include Certified 
Work or Prevailing Wage Work. 

Decrement: This term is used in the HR and Pay Stubs modules. It refers to the reduction 
or deduction of accumulated time off from an employee's leave balance. 

Distribution: In the context of AP Invoices, Distribution refers to the allocation or 
assignment of costs to various Commitments, Jobs/Projects, Cost Codes, Categories or G.L. 
Accounts within a construction company. This process is essential for accurately tracking 
the financial performance of different Jobs/Projects and segments of the business. In hh2, 
Distributions are partially coded during the Data Entry step and final coding of Distributions 
can occur during the Workflow phase of the hh2 Document Flow-Invoice Process.  

Distribution Split: This term is used in the Document Flow (AP) and Remote Payroll 
modules. When a single invoice must be coded to more than one Commitment, 
Job/Project, Cost Code, Category or GL Account (General Ledger), the user may elect to 
split the Distribution into multiple distributions. Users have the option to calculate the 
value of one of the Distributions to adjust to the remaining value after all other distributions 
are added up. Negative Distributions are permitted when necessary (although not 
common). This feature can also be utilized for Equipment in the Remote Payroll module.  
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Document: hh2 Document Flow is primarily a Document Management system. Documents 
refer to the financial instruments that hh2 Document Flow currently manages: Invoices, 
Reimbursements, Credit Card Transactions, and Application for Payments. Sometimes, the 
term Image is also used during the Data Acceptance step for images that need to be 
recognized by the Optical Character Recognition (OCR) before becoming a Document. The 
standard hh2 Document format is a Searchable PDF (either native pdf, or from raster 
images that have been run through the OCR process built into hh2 Document Flow Data 
Entry). 

Document Acceptance: This is the process of accepting invoices that were captured using 
one of the many methods available to hh2 Document Flow Customers. Invoices can be 
captured by email, document scanner, monitored network folder, API, manual web upload, 
scanned by app, and uploaded after “opened in” an app. In cases where large groups of 
invoices were scanned in batch, typically by a document scanner, hh2 has advanced 
options to delete blank pages or split a document into multiple invoices and can be 
configured to combine multiple documents into a single invoice. Images may be enhanced 
and OCR’ed into Searchable PDF format. 

Document Class: Utilized in the hh2 HR module. Document Classes provide a means to 
categorize available document types, appearing on Employee Records and Job/Crew 
Dashboards. For instance, documents may be related to 401K benefits, job offers or even 
company newsletters. This feature allows for a quick search on types of documents.  

Document Flow: The hh2 module that streamlines the invoice management process. Also 
referred to as the AP Module.  

Document Flow Process for Invoices: The four-step process of Document Acceptance, 
Data Entry, Workflow, Final Review and Export of invoices in the hh2 Document Flow (AP) 
system. 

Document Flow for Receipts: The five-step process of Capturing and Uploading the 
Receipt Image, Receipt Coding, Importing Credit Card transactions, Workflow routing and 
the Final Review and Export to the accounting system. This process is performed in the 
Document Flow (AP) module. 

Document Flow Process for Reimbursements: The four-step process of Capturing and 
Uploading receipts for reimbursement, Coding the reimbursement, sending it through a 
Workflow and conducting a Final Review and Export to the accounting system. This 
process is performed in the Document Flow (AP) module.  
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EEO-1 Reporting: Referred to in the hh2 HR module. The EEO-1 (Equal Employment 
Opportunity-1) report is a mandatory survey for U.S. employers with 100 or more 
employees, collecting data on workforce composition by race, ethnicity, gender, and job 
category. It helps identify and address workplace discrimination and promotes diversity 
and inclusion. 

Entity: This term is used in the Document Flow (AP) module. It refers to the Business Unit 
used by the ERP accounting system. Sometimes the business entity is part of a larger 
parent company or entity. Sometimes business entities are created specifically for a large 
single project. Data Entities are abstract concepts that identify the properties that make it 
unique. Examples of data entities include Job, Employee, Cost Codes and GL Accounts. 

Equipment Revenue: Within the Remote Payroll module, construction companies can 
monitor the duration of equipment usage. Employee time is linked to specific pieces of 
equipment for revenue tracking purposes. The Equipment Revenue undergoes an Approval 
Path and is ultimately exported to the accounting system. 

ERP: Enterprise resource planning (ERP) is a type of software system that helps 
organizations automate and manage core business processes for optimal performance. In 
this case, the ERP system refers to the construction accounting system, such as Sage 300, 
Construction and Real Estate, Sage Intacct, Viewpoint Vista, and QuickBooks.  

Export: Refers to the process of moving data from the hh2 system to the construction 
accounting system or ERP. 

Extra: Sage 300 Construction, Real Estate, and Sage accounting systems (ERPs) opted to 
use a separate entity for a child job called an Extra. It denotes a smaller portion of a parent 
job that can be managed like a normal job. Most other construction accounting systems 
(ERPs) have opted to use hierarchal jobs (parent jobs and child jobs or sub jobs) instead of 
Extras. An example of an Extra might be an auditorium or exhibit hall as part of a larger 
complex. 

Field User: A construction company employee that uses hh2 software out in the field. 

Field Work: Work that happens in the field, versus in the Shop or Office. 

Finalize: In the context of Field Reports, this refers to the process of locking down a log, so 
no further edits are allowed. Logs not finalized within the period specified in the System 
Setting (FR>Settings>System Settings>General Settings tab>Auto-finalize logs) will be 
automatically finalized by the hh2 system. This will protect the legal integrity and credibility 
of the Daily Log. However, there is the ability to add an addendum. Unit 
Production/Activities data is synchronized to the Sage 300 accounting system, as well as 
Remote Payroll data from the Remote Payroll module at the time of finalization.  
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Final Review and Export: During this step, invoices or are reviewed and then exported to 
the accounting system. Mistakes can either be corrected and invoices (for Document Flow) 
or time (for Remote Payroll) are sent back to earlier stages in the Workflow for revision. If 
everything checks out, the Invoice (for Document Flow) or Labor Time Sheet (for Remote 
Payroll) is approved and then exported to the accounting system (ERP). 

Foreman: This role varies based on the construction company’s business model and 
needs. Typically, this person is responsible for managing a crew of construction workers. 
For larger jobs, with multiple crews, a Foreman usually reports to a Superintendent. Within 
the hh2 system, this job role may be set up as a part of the Workflow process. Foremen 
usually approve standard invoices, receipts, or reimbursements and time in the Document 
Flow (AP) and Remote Payroll modules. Further, allowed Formen may have access to 
certain employee records in the HR module.  

Fringe: The employer paid portion of the employee's benefits, such as health care costs. 
This term is used in the HR and Pay Stubs modules. 

General Ledger or G/L Account: A comprehensive record of all financial transactions and 
accounts for an organization, providing a snapshot of its financial health. Sometimes 
referred to as the G.L. For construction accounting systems, the Job Cost is an abstraction 
of the G.L. that makes it easier to record transactions related to specific cost codes on 
specific jobs. Overhead expenses are commonly coded directly to a G.L. Account or to an 
overhead Job that rolls up to the G.L. Examples of overhead expenses may include rent, 
insurance, taxes, and salaries of office staff.  

Global Password: A separate password in addition to the Administrator’s own log in 
password. It is utilized when organizations have multiple Administrators, and only certain 
Administrators should have access to the Security Group Setup. See Security Group. This 
provides a means to create security around Pay Stubs and employee records in the HR 
module. 

Header: The portion of the invoice that uniquely identifies information for the entire invoice 
but is separate from the distribution (where costs are allocated to) data. Typical Header 
information includes, but is not limited to, items like Vendor, Invoice Date, and Due Dates. 
Data requirements for the Header are heavily based on individual construction accounting 
system requirements. This term is used in the Document Flow (AP) module.  

Hh2 Admin: An hh2 employee that assists with set up of the construction company’s hh2 
site.  
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HIPPA Regulations: Referred to in the hh2 HR module. HIPAA (Health Insurance 
Portability and Accountability Act) regulations aim to protect employee privacy by 
establishing standards for the confidentiality and security of information, ensuring that 
sensitive details are safeguarded in the workplace. This term is used in the HR module.  

Home Page: the initial landing page a user is brought into when signing into hh2. 

Icon: a small graphical representation or symbol that represents an object, concept, 
action, or function. They are often designed to be easily recognizable and can represent 
anything from simple actions (like saving a file) to more complex concepts (like settings or 
navigation). For the purposes of this document, they may also be considered a button. 

Identifier or Site Identifier: Refers to the company’s unique hh2 URL site name. For 
example, if the construction company is ABC Construction, the identifier of “ABC,” might 
be included in the URL. For example: “https://abc.hh2.com". 

Image: This refers to any sort of raster image (like photos) or scanned invoices that have 
been uploaded to the hh2 system that have not yet been accepted into the AP-Document 
Flow module. Once these images have been run through the Document Acceptance 
process, they become Documents. Most of the time, these images become Invoice 
Documents, but can also become Credit Card Receipts or Reimbursements. Images may 
be uploaded in other hh2 modules such as Field Reports and HR. 

Import: The process of moving data into the hh2 system from the construction accounting 
system or ERP. There are some places where data can be manually imported into hh2 like 
credit card transactions. Sometimes data can be imported by hh2 staff in excel format. For 
instance, a list of employees to set up as users. 

Invoice: A bill a company receives from a vendor. Many vendors send invoices by email and 
are already in a native searchable pdf. For paper invoices that must be scanned, invoices 
may be received in an image format that must be run through hh2’s OCR software in Data 
Entry before data can be automatically captured. This term is used to in the Document 
Flow (AP module).  

Invoice Acquisition: Refers to how an invoice was acquired. Invoices can be acquired by 
email, document scanner, monitored network folder, API, manual web upload, scanned by 
app, and uploaded after “opened in” app. This term is used in the Document Flow (AP 
module).  
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iPaaS (Integration Platform as a Service): An hh2 product, depending on the software 
version, it may be seen as the OCM module on the Home Page. This links and syncs data 
between hh2 and certain 3rd party products such as Procore. hh2 Document Flow is 
bundled with hh2’s Integration Platform as a Service or iPaaS. iPaaS is configured to 
automatically pull data from the construction accounting system (ERP) and reconcile it 
with the online copy within hh2. This ensures all accounting codes like Jobs, Costs codes, 
employees and others are always kept current within hh2. hh2’s iPaaS also ensures that 
changes made in hh2 are synchronized automatically to the ERP. In some cases, hh2’s 
iPaaS can also be configured to synchronize data from 3rd parties, such as Procore, directly 
to the ERP. 

Job: A job is a contractual obligation to perform a specified scope of work for a customer. 
Also called a Project, a job can have multiple commitments (subcontracts and purchase 
orders) by vendors associated with it. hh2 Document Flow is set up to allow permissions to 
be configured by job and job role. Sometimes jobs can have child jobs or sub-jobs. In Sage 
300 Construction and Real Estate, these sub-jobs are called Extras. In most other 
construction ERPs, they are simply child jobs of a larger parent jobs in a hierarchal 
relationship. Job and Project are used interchangeably by hh2. Time may be coded to Jobs 
in Remote Payroll. 

Job Code/Number: A unique code assigned to a specific project or job within a 
construction company. This code is typically set up in sections to help make it easier to 
identify the job. It helps track and organize financial transactions, costs, and revenues 
associated with a particular project. Job Numbers are used to differentiate and manage 
various ongoing projects, allowing for accurate cost allocation, budgeting, and financial 
reporting. Job Codes can be alphanumeric and may include separator characters for each 
section. For example: “200-24” might be the 200th project the company has done, and it 
started in the year 2024. 

Job Phase: Although some within the construction industry may refer to phases of 
construction, most of the time it refers to the work breakdown structure in Job Cost. Cost 
Codes and Phase Codes are used interchangeably. Some construction accounting systems 
use hierarchal cost codes or phase codes. Hh2 imports them as separate codes. 

Level: In hh2, levels within the Workflow handle invoice review, approval, and passing from 
lower to higher levels, culminating in data export to the accounting system. Levels are more 
of a loose term as routing within a workflow can have decisions and branching logic that 
make levels more abstract. 

Module: Refers to hh2’s product offerings: AP-Document Flow for Invoices, Credit Cards, 
and Reimbursements;  RP-Remote Payroll; HR-Human Resources; PS-Pay stubs; and FR-
Field Reports.  
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OCR: Optical Character Recognition. It is a technology used to convert raster documents 
(any documents that use colored pixels to make a larger image), such as scanned paper 
documents, raster PDF files (pdf files that come from scanned images), or images taken by 
a digital camera, into hh2’s native file format, searchable pdf. OCR technology enables 
computers to recognize and extract text from these raster images, turning them into 
machine-readable text that can be manipulated, searched, and analyzed. OCR is used to 
easily pre-fill header information on invoices.  

Overhead Expenses: Expenses that are not coded directly to a job or project. These might 
include certain types of office workers or laborers assigned to maintain equipment, for 
instance. Many times, overhead expenses are coded directly to GL Accounts but 
sometimes companies choose to set up an overhead job to track overhead as it gives them 
advanced reporting available in the job cost system. 

Page: The terms Page, Screen, Form or Window are used interchangeably in this 
document. All referring to the location of the visual display of information. 

Parent: Some concepts in construction are hierarchal, meaning they are organized and 
structured with parents and children. For business entities, sometimes child companies 
are part of a larger parent company. For data entities, some abstract concepts fall as child 
entities of another larger entity, such as Extras or Sub jobs being a child of a larger Job, or 
Cost Codes being a child entity to the Job that tracks costs. See: Child. 

Pay-app: Refers to a payment application or payment request. It is a formal document 
submitted by a contractor or subcontractor to request payment for work completed on a 
construction project. The pay app outlines the amount of work done, materials used or 
stored to date, and any other billable items, along with their associated costs. In hh2 this is 
currently in Beta.  

Pay Identifier: This is the identifier for a type of pay within the accounting system.  

Payroll Group: In the Remote Payroll module, a Payroll Group refers to a collection of 
employees who share similar payroll characteristics. For example, all salaried employees 
may be assigned to one Payroll Group, while another Payroll Group may include all hourly 
employees. 

Pay Type: This is how hh2 distinguishes types of pay. For example, Regular Pay, Overtime 
Pay, Paid Time Off, Sick Pay and others. Pay Types can be set to display, or not, on hh2 
Pay Stubs. This term is used in the Remote Payroll, HR, and Pay Stubs modules. 
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Picklist: Also known as a dropdown list, is a menu-like interface element often seen in 
forms and websites, offering users a set of predetermined choices to choose from, 
enhancing data entry efficiency and uniformity. In hh2, Picklists come in the form of Cards 
or dropdown lists. 

Prevailing Wage Work: The government guarantees an assured wage for certain types of 
work (by certified class) on government Jobs. Examples of such Jobs may include work on 
schools, highways, or government buildings. Other interchangeable terms include Certified 
Work or Davis Bacon. 

Project: A project is a contractual obligation to perform a specified scope of work for a 
customer. More commonly called a Job within hh2, a project can have multiple 
commitments (subcontracts and purchase orders) by vendors associated with it. hh2 
Document Flow is set up to allow permissions to be configured by job and job role. In the 
Remote Payroll module, Payroll Groups may be assigned to Jobs. Sometimes jobs can have 
child jobs or sub-jobs. In Sage 300 Construction and Real Estate, these sub-jobs are called 
Extras. In most other construction ERPs, they are simply child jobs of a larger parent jobs in 
a hierarchal relationship. 

Promote: In the context of Workflows, "Promote" refers to the capability to advance an 
approval from one level in the approval process to the next without requiring approval from 
the current level. This functionality is utilized when an approver is unavailable to approve 
time or receipts. Additionally, "Promote" signifies that the time or document is currently at 
a lower level than the logged-in user. This term is used in the Document Flow (AP) and 
Remote Payroll modules. 

Punch Clock: In the Remote Payroll module, the Punch Clock feature enables employees 
to log their time by punching in and out, including coding. It is important to note that this 
feature should not be confused with the legacy Attendance Punch feature, which does not 
capture coding. Similar to labor and equipment, Punch Clock time follows an Approval 
Path and is eventually exported to the accounting system. 

Push Notification: A push notification is a short message or alert sent to a user's device. 
These notifications "push" information to the user without requiring them to actively open 
them. They appear on the device's screen, usually accompanied by a sound. 
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Queue Digest: A queue digest, often referred to as a "queue summary" or "queue report," 
is a consolidated overview of activities or items in a queue. It provides a snapshot of the 
status, progress, and contents of the queue at a specific point in time. This summary can 
include information such as the number of items waiting, being processed, or completed, 
as well as any relevant details about those items. Queue digests are often used to help 
users or administrators quickly understand the state of a queue without having to review 
each item individually. Specific to hh2’s Document Flow, a Queue is a summary of all 
invoices in the workflow requiring action from the user.  

Receipts: Receipts are written or electronic documents that serve as proof of purchase. 
Purchases are typically made on the construction company’s credit card, then uploaded 
into the hh2 system by snapping a picture. The AP Manager or Administrator then imports 
credit card transactions from the construction company’s bank. Once this process occurs, 
the receipt is now converted to and considered an invoice in hh2. This term is used in the 
Document Flow (AP) module. 

Reclaim: In the context of Workflow or Approval Path, "Reclaim" denotes the action of 
retrieving time or documents back to one's own level for approval. This feature allows users 
to bring items back to their stage in the approval process for further review or necessary 
adjustments. It also serves as an indicator to the individual in the highest level of the 
Workflow or Approval Path that either documents or time is ready for export. This term is 
used in the Document Flow (AP) and Remote Payroll modules.  

Reimbursements: Unlike receipts, reimbursements are purchases made directly by the 
employee, either by cash or on their personal credit card. Receipts, on the other hand, are 
purchases made on a company credit card. Once uploaded and coded, reimbursements 
move through the Workflow as an invoice. Finally, they are exported to the accounting 
system. This term is used in the Document Flow (AP) module. 

Roadblock: In the context of the time approval process, a "Roadblock" refers to an 
obstruction disrupting the normal flow of the approval process. Payroll Managers and 
Administrators can leverage the Roadblock feature to identify the specific level within the 
Approval Path where the obstruction is occurring. This feature aids in pinpointing issues 
and streamlining the resolution process. 

Section/Tab: These terms are often used interchangeably. This is the portion of the Daily 
Log/Field Report that contains specific data related to the Section. For instance, the 
Weather Section (tab) stores information about the current logs weather conditions. This 
term is used in the Field Reports module.  
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Security Group:  Security Groups: Utilized to in the hh2 HR and Pay Stub modules. 
Security Groups are utilized to categorize users, including HR Managers and other 
authorized individuals, into specific groups, dictating their access to employee records and 
pay stub information. The configuration of Security Groups is restricted to System 
Administrators. 

Shop: An in-house workshop where employees of a construction company perform work 
such as welding for Jobs. This may also include fixing and maintaining company 
equipment. This is the opposite of Field Work, where work occurs on the job site.  

Skills Matrix: In the HR module, the Skills Matrix allows the HR Administrator the ability to 
set up skills matrices that tie into the Evaluations tab on the Employee Record, Jobsite 
Dashboard, and the Crew Dashboard. Furthermore, Skills appear on Classifications and 
Locations reporting. 

Synchronization (Sync): The process of syncing data between hh2 and the construction 
accounting system or ERP. This can be either importing or exporting data to and from hh2. 

Standalone: If a construction company uses hh2 without an ERP, then they do not 
synchronize data to and from an ERP accounting system using hh2’s built-in iPaaS. Some 
features and functionality will behave differently without this automated integration. Setup 
for the system will differ as well. Generally, this is not considered a best practice if the 
integration for the ERP in context already exists. However, construction companies that 
use non-construction accounting systems or rarely used construction ERPs may choose to 
use hh2 standalone. 

Superintendent: Oversees the entire project in the field. These individuals typically report 
to a Project Manager and holds teams and foremen accountable for completion of work. In 
some smaller construction companies, the Superintendent acts as the Foreman and 
Project Manager. 

System Administrator (Also referred to as Global Administrator): This is typically the IT 
person at the construction company. The System Administrator’s role is to roll out the hh2 
product at the construction company. They usually work with synchronization tools to 
ensure data is properly synchronized between hh2 and the company’s accounting system 
and may be involved with the initial setup of user accounts and permissions.  

Unit: A standardized quantity or measure used to quantify and price specific tasks, 
materials, or services within a project. 
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Unit Cost: The unit cost represents the expense of obtaining or creating a single unit of an 
item, including materials, labor, equipment, and overhead. This cost estimation method 
aids in calculating the total cost for a project component by multiplying the unit cost by the 
required quantity. For example, when building a concrete foundation, there may be a unit 
of "cubic yards of concrete." The unit cost would include the cost of materials (cement, 
aggregates), labor, equipment, and other expenses required to produce one cubic yard of a 
concrete foundation. 

Unit Production: This term is referenced in the Field Reports module. In construction, Unit 
production involves quantifying work tasks using standardized units, such as square 
footage or linear feet. An example of unit production is tracking the square footage of 
drywall installation. This method allows for precise measurement, tracking, and 
management of construction activities. By breaking down tasks into measurable units, 
construction professionals can more accurately estimate costs, assess project progress, 
and allocate resources efficiently. 

User: Anyone that logs into hh2. They must have a user account, with a username, 
password, first and last name and email address and ideally a cell phone number.  

Username and Password: Within hh2 software, a user’s username and password are 
considered global, and can be used across all the hh2 modules that have been purchased. 

User Preferences: Customizable settings that allow individual users to tailor the software's 
functionality, appearance, and behavior to their specific needs. 

User Roles: User Roles define specific permissions, access levels, and responsibilities 
assigned to different individuals within a system, ensuring proper data security and 
functionality based on their roles and responsibilities. In hh2 Document Flow, for example 
key roles include the 1) System Administrator 2) Administrator 3) AP Manager 4) AP Clerk 
5) Office User and 6) Field User. The key differentiator between the Administrator and 
Manager is that the Administrator can create new users and grant permissions to users.  

Vendor: For Invoices in hh2 Document Flow, a vendor refers to an Account Payable (AP) 
Vendor, which is a supplier for Purchase Orders or a Subcontractor for a Subcontract. All 
Commitments have an AP Vendor assigned to it. For Credit Card transactions, a Vendor 
refers to the business that the item was purchased from in the credit card transaction. For 
reimbursements, some companies choose to set employees up as Vendors so that 
approved reimbursements can be processed via AP check. 
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Workflow: A system designed to facilitate the routing and approval of time, invoices, and 
other documents down a predefined path with branching logic. Hh2’s workflows are 
designed with Role Based Approval so that very few workflows need to be configured. 
Decision nodes in the workflow determine how time, invoices and other documents will be 
routed in the workflow. For example, invoices can be routed in one direction if certain 
criteria are met, or the opposite direction if it is not. For instance, one possible 
configuration is to route the invoice in one direction if it is coded to an overhead GL 
Account or another direction if the invoice was coded to a job. Another possible 
configuration is to route the invoice in one direction if the invoice is over a certain dollar 
amount or another direction if it is less. Labor time, on the other hand, may be routed to 
various levels of job roles for approval and rejection through an Approval Path. This term is 
used in the Document Flow (AP) and Remote Payroll modules.  
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Change Log 
A Change log is a documented list of changes between one version of a document and the 
next version.  

Between Version 1 and Version 2 of this document the following changes were made: 

▪ The addition of the Changelog. 
▪ The addition of the newest version of the Glossary of Terms. 
▪ The removal of the Change Background feature from the Home Page section. 


